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Thanks!
Thanks for choosing ReBirth RB-338!

It is our sincere belief that this program will prove to be a valuable, exciting and
ative tool in your music making. Our primary goal during the development of R
Birth RB-338 has been to deliver what software synthesis for so long has prom
a real alternative to expensive and – in this case – partly “extinct” hardware. W
simply love synthesizers, and this love has been a major motivation during th
velopment process.

Now we hand our creation over to you. We hope you will have as much fun u
it as we had designing it!

We’d also like to take this opportunity to thank everybody that helped out dur
development, for the enormous support!

Please stay in touch, preferably via the web sites (www.propellerheads.se an
www.steinberg.net). We need your comments and ideas for the future!

Again, thanks!

Propellerhead Software/Steinberg Soft- & Hardware GmbH

About this Documentation

Using Acrobat Documents

The following methods will help you find the information you require:

• Use the Table of Contents provided by the Adobe Acrobat Reader pro-
gram.

• Use the Adobe Acrobat Reader Find function.
• Click on a cross-reference (green text) to jump to the respective topic.

It is possible to print out this document or parts of it.

Additional Information on how to use the Adobe Acrobat Reader program can
found in its on-line Help.

How the Documentation is Organised

The documentation for ReBirth RB-338 is divided into two parts:

• The printed documentation.
This describes how to install the program and gets you started using it.

• This on-line documentation
This contains detailed instructions, reference material, troubleshooting, glos-
sary and index.
- 7 - 
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Introduction
It is extremely important that you make the correct audio settings on your com
ter. Please follow the instructions for each computer platform, below.

Windows Computers
The following text is a duplication of the help file that appears automatically w
you first launch ReBirth for Windows. If you have just followed the on-screen 
structions, you naturally don’t need to do this all again!

Selecting an Audio Card Driver

● If you are unsure about the terminology and concepts used in the following 
text, look up the chapter ”Audio on Computers” in this manual.

First, you must determine if you have DirectX installed on your system, or not

1. Open the Preferences dialog and locate the sound card settings.

The sound card settings in the Preferences dialog.

2. Pull down the Audio Card driver pop-up and select the last item.

3. Check the text below the box, does it say ”Driver type: Direct X”?

• If it does, you have DirectX installed. Proceed to the next step, “Finding 
out if your DirectX Driver is Emulated or not”.

• If it doesn’t, instead skip to the heading “Selecting an MME Driver” below.
- 9 - 
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Finding out if your DirectX Driver is Emulated or not

If (and only if) you have DirectX installed you need to find out if the audio card
driver is emulated or not. You should not use an emulated DirectX driver with Re-
Birth RB-338. To find out which type of driver you have, proceed as follows:

1. Pull down the Audio Card driver pop-up and select the drivers that corre-
spond to the card you want to use, one by one.

2. For each one, check the text after ”Driver type:” below the pop-up.

• If one says Direct X only (and the word emulated is not mentioned), use 
this driver. Then proceed to the heading “Setting the Audio Card Buffer”, 
below.

• If all say emulated, you should not use any DirectX driver. Instead read 
“Selecting an MME Driver”, below.

Selecting an MME Driver

To select the appropriate MME (Multimedia Extensions) driver, proceed as fo
lows:

1. Pull down the Audio Card driver pop-up and select the first item on the 
menu that corresponds to the name of the card you want to use.
You should avoid choosing generic driver names.

2. Check the text below the box, it should say ”Driver type: MME”. If it 
doesn’t, select another driver.

3. Proceed to the heading “Setting the Audio Card Buffer”, below.

Setting the Audio Card Buffer

It is very important that you trim the buffer setting properly. The buffer setting 
balance between fast response to control changes on one hand and “safe” au
playback on the other.

1. Open one of the demonstration songs.

2. Activate Playback.

3. Open the Preferences dialog, from the Edit menu.

4. In the Preferences dialog, locate the Playback performance slider and 
drag it all the way to the right.

5. Now drag the Playback Performance slider to the left, a bit at a time. Try 
positions further and further to the left, until the sound starts ”breaking 
up” and the Underruns indicator starts incrementing.

6. Drag the fader a little bit to the right, so that the sound is OK again.
- 10 - 
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• If you use DirectX under Windows 95, you will normally be able to trim 
the buffer sizes down to between 40 and 90 milliseconds. 

• If you use MME under Windows 95, the same figure will normally be 
around 160 milliseconds.

7. Close the dialog.

You are now finished with your audio settings for ReBirth. The settings you ju
made are stored automatically.
- 11 - 



    

 it to 
at 

er ap-

ons 
rrect 
k.

    

edy 
other 

  

ize 

   
Macintosh Computers

Why are there two ways of Playing back Audio?

ReBirth uses the Sound Manager on the Macintosh to play audio. This allows
play in the background and happily co-exist with other audio applications. Gre
care has been taken to make ReBirth compatible with all other Sound Manag
plications. This is what we call “Multitasking friendly” audio playback.

However, there’s a problem with some combinations of Sound Manager versi
and certain Mac hardware, where ReBirth can’t automatically determine the co
“audio buffer size”. This might lead to crackles or glitches in the audio playbac

● We recommend all users to check the buffer size, as described below, even if 
you don’t have problems with your audio. If you can use a lower buffer setting 
than the default, the program will be more responsive to control movements.

On some rare occasions, adjusting the buffer size might not be enough to rem
the Sound Manager problems. In this case, you have the option of selecting an
method for playing back audio, which we call “Crackle safe”. Selecting this 
method has some drawbacks though, see the end of this chapter.

Setting the Correct Buffer Size 

Normally you should leave the Sound Manager Audio setting at “Multitasking 
friendly”. However, you should make sure you have the correct audio buffer s
setting. Proceed as follows:

1. Open one of the demonstration songs.

2. Activate Playback.

3. Open the Preferences dialog, from the Edit menu.

4. Locate the Buffer size pop-up.

5. Select the smallest buffer size that allows you to play back audio without 
problems.

6. If none of the buffer sizes seem to work, switch from “Multitasking 
friendly” to “Crackle safe”, in the Preferences dialog and set the buffer 
pop-up to the value closest to “(1024)”.
- 12 - 
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About the Crackle Safe Option

Selecting the Crackle Safe option will make sure that ReBirth RB-338 
works properly in all situations. However, the mouse pointer will not move 
as smoothly and you might possibly run into audio problems with other 
programs playing via the Sound Manager. Furthermore ReBirth RB-338 
might possibly disturb other background processes such as networking.

System 8 note

System 8 users should make sure virtual memory is turned off in the Memory
trol panel, since it affects audio playback.

If you have to have virtual memory activated for some reason, you might have
raise the buffer settings drastically to get clean audio playback.
- 13 - 
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Introduction
This chapter introduces you to some basic methods and concepts in ReBirth 
338. To get a “hands-on” introduction to the program, read the quick tutorials in
printed documentation.

Song Mode vs. Pattern Mode

The Song/Pattern Mode switch.

These are the two major modes in ReBirth RB-338. Basically, Pattern mode i
creating Patterns and experimenting with sounds and other settings. Song m
for stringing Patterns together and recording the automation of controls. Here 
couple of the major differences between the two modes:

• In Pattern mode, the controls are all manual, that is, if you move them they 
stay where you left them. In Song mode, the controls are all automated, 
that is they will move automatically on playback, if movements have been 
recorded. You can not move the controls during playback in Song Mode.

• In Pattern mode, the Loop feature has no function, the currently selected 
Patterns always loop. In Song mode the Loop is used for repeating any sec-
tion of the Song.
- 15 - 
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Setting Values
Apart from the normal operations, double clicking, dragging, using menus, etc
Birth RB-338 employs some special techniques for changing values:

Knobs

Knobs come in a number of different shapes.

Knobs are always operated in the same way: To change a value, press the m
button over the knob, and drag up/down.

Faders

An example of a fader.

To move a fader, press the mouse button over the handle and drag up/down.

Value displays

A value display.

The value displays have two small arrow buttons located beside them.

• Clicking either of these buttons changes the value one step up/down.

• Keeping the mouse button pressed over an arrow, makes the value 
change continuously.
- 16 - 
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Using the Computer Keyboard
The computer keyboard is used for four purposes:

• For menu shortcuts.
These are listed on page 192.

• For Transport controls (Play, Stop, Rewind etc).
This is mainly done from the numeric key pad. Again see page 194.

• For quick programming of the synthesizers.
To do this, activate “Program Synth from Keyboard” on the Options menu. For 
more information, see page 37.

• For Pattern switching.
For this to work, “Select Patterns from Keyboard” must be active, on the Op-
tions menu. See page 194 and below for details.

MIDI
MIDI is used for two things in ReBirth RB-338.

• For synchronization to other equipment, see page 79 and page 89.

• For Remote Control, see page 104.

Real Time Operation
All operations in ReBirth RB-338 can be executed while the program is playin
even saving to disk! There is no need to turn off playback to perform any opera
- 17 - 
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Pattern Selection

The Pattern selectors.

How to Select a Pattern

Each of the three main sections has 32 Patterns, arranged in 4 Banks of 8 Pa

• To select a Pattern in the current Bank using the mouse, simply click on 
the corresponding Pattern button.

• To select a Pattern from the computer keyboard, make sure “Select Pat-
terns from Keyboard” is activated on the Options menu and press the rel-
evant key, as indicated in the figure below.

• To select a Pattern in another Bank, first select a Bank, using the buttons 
labelled A to D, then select a Pattern.
No change takes place until you actually select a Pattern.

• You can also select Patterns via MIDI, see page 104

Switching a Section Off

You can turn a section off completely, by deactivating it in the Pattern section. 
is equivalent to selecting a silent Pattern.

A section, activated and deactivated.

ÍZXCVBNM,./

ÊQWERTYUIOP
ÒASDFGHJKL;

11234567890

Synth 1 - Pattern 1 to 8

Synth 2- Pattern 1 to 8

Rhythm - Pattern 1 to 8
- 18 - 
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Pattern Changes take Effect on the Next Downbeat

When you select a new Pattern, the change doesn’t take effect until the end o
Pattern.

This can be used to good effect, especially when switching Patterns from the
puter keyboard; you have time to hit the right key in advance.

Please note that this is true for each individual Pattern, regardless of its length
very short Patterns, it is more important to hit the key or press the mouse butt
the right time.

About Focus and the Focus Bar
Many operations may only be performed on one of the three main sections in
Birth RB-338. To see which section “has the focus”, look for the vertical orang
bar, to the right of the Pattern selectors.

In this example, the rhythm section has the focus, as indicated by the orange bar.

The focus can be moved to the relevant section, in one of three ways:

• By clicking with the mouse in the relevant section.

• By selecting a Pattern in a section.
This automatically sets the focus to that section.

• By using the up and down arrow keys on the computer keyboard.
- 19 - 
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The Mixers

A Mixer

Section Mixers

In the Mixer parts of the various sections, you can adjust the relative balance o
ume. You can also adjust things like panning (stereo positioning) and effects.
is all covered in great detail in the chapter “Mixing & Effects” . For now please note
that:

• If a section is too loud or weak, use the volume faders to balance it.
The small meter gives you an indication of the output level from this section.

• If you want to move the sound left/right in the stereo image, use the Pan 
control.

Master Level

The Master Level section.

The master level adjusts the overall audio output from the program. For more
see the next paragraph.
- 20 - 
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About Levels
You have to be slightly careful when adjusting levels so that you don’t get any
wanted distortion on the master output, due to a phenomenon called clipping
the other hand, levels that are too low can lead to an undesired amount of no

● Clipping cannot occur within an individual section, even when it’s volume is 
set to maximum. Any distortion that appears can always be removed by low-
ering the Master level, as described below. 

Here’s our recommended procedure for setting levels:

1. Set up a rough balance between the three sections.

2. Lower or raise the master level so that the signal on the meters only hit 
“the red”, during the loudest passages.

3. If you change your mixer levels, or adjust the sound on the synth section, 
be sure to re-check the master level.

So why is it so important to adjust the levels correctly? Those of you who only h
experience of analog equipment should note that digital levels are completely
ferent in nature. A digital audio system can by definition only represent a limit
range of levels correctly. This is called the dynamic range.

When you try to exceed the dynamic range (when the signal is amplified to a 
the system can’t handle), hard clipping occurs, and the sound will be distorted
very harsh, unpleasant way (if you like this distortion, go ahead and use it, we 
mind. We just want to make sure you don’t run into it unintentionally.)

On the other hand, if the levels are too low the signals may not be represented acc
rately enough and unwanted noise will be audible.

Systems based on personal computers are slightly different compared to ded
digital audio systems, by nature. Maintaining the dynamic range properly is e
more critical in a personal computer system. Therefore, in our efforts to provide
with the best possible sound quality in all situations, we have handed over som
the responsibility to you, the user.

It’s up to you to check and adjust the master level. This method ensures the h
possible sound quality, in all situations.

The level should very rarely 
reach this marking.
- 21 - 
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Preparations
1. If required, create a New song or Open an existing one.

2. Make sure Pattern mode is selected.
You can only program Patterns in Pattern mode. See page 15.

3. Select a Pattern to program.
How to do this is described on page 18.

4. The Pattern you select can be empty or it can be one already playing 
some rhythm, it doesn’t matter. If it already plays something, you can ei-
ther clear it (see later in this chapter) to start over from scratch, or mod-
ify the existing rhythm as you like.

● Please note that it is often convenient to make copies of the same basic 
rhythm into a few Pattern locations. You can then make minor or major varia-
tions to this rhythm, in each of the Patterns, and use them in various parts of 
the Song. For more info on copying, see page 45.

Soloing the Rhythm Section
If you want to make sure you are only hearing the rhythm section while progr
ming, you will want to turn off all other sections:

• Click on the on/off button (in the upper left corner) in the mixer for each 
synth, to turn them off.

With both synths turned off, you will only hear the rhythm section.
- 23 - 
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Programming and Playback
You can program rhythms, either when the program is in stop mode or when 
playing. It doesn’t really matter which, but the most convenient is probably to h
playback going so that you will hear how the Pattern evolves as it repeats.

Selecting Sounds
Before you can start programming any notes, you must of course select a sou
This can be done in several ways:

• By using the large rotary knob to the right in the rhythm section.
Drag up/down, as always.

The sound selector knob.

• By clicking directly on the sound name legends above the colored step 
buttons.

The sound selector buttons.

• Via MIDI, see page 104.

A list of all sounds can be found on page 126.

About “Shared slots”

Some instrument “slots” are shared by two sounds. One example is Low Tom
and Low Conga (LC). You select between shared instruments as the illustratio
low indicates:

More about shared instruments on page 28.

First click in either of these two places
...then click on the switch.
- 24 - 
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Adding and Removing Notes
To add notes with the selected sound, proceed as follows:

• Click on the colored step buttons, to add a note with the selected sound.
The step buttons that are lit up indicate programmed notes.

The sixteen step buttons represent sixteenth notes in a measure. If you for ex
add notes at step 1 and step 9, you will get sounds at the downbeat and on th
quarter.

Here, a bass drum is programmed on step 1 and 9.

• You can remove notes in the same way, by clicking on steps that are al-
ready lit up.

Dragging to Add/Remove Notes
You can also drag to add/remove a number of notes at the same time. Wheth
drag operation adds or removes notes depends on the step where you start dra
If this is empty, you will be adding, if it already plays a note, you will be remov

If for example you want to add a sound at all sixteenth notes in a Pattern, pro
as follows:

1. Locate a step where there is no note (not lit up).

2. Position the pointer over this step, and press the mouse button.

3. Drag back and forth over the steps, without releasing the mouse button.

4. When all step buttons are lit up, release the mouse button.

Dragging to add notes on all sixteenths.
- 25 - 
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Tap Recording
The computer keyboard can be used for programming any and all rhythm sou
by “tapping” the correct keys. The key row starting with A is used for accessing
drum sounds, starting with BD, Bass Drum. The accent is reached from the m
key in the top row.

● The key mapping i based on an American keyboard layout!
On the Macintosh, the keys are always in the positions indicated in the pic-
ture above, but the labels on the keys may be different in your country.
Under Windows, you may need to press other keys, depending on the key-
board layout in your country.

To use Tap Recording, proceed as follows:

1. Make sure you are in Pattern mode.

2. Create a simple beat as a metronome, so that you know where in the beat 
you are.

3. Make sure “Program Synth from Keyboard” is activated on the Options 
menu.

4. Activate playback.

5. Make sure the rhythm section has the focus.
See the main ReBirth manual for more info on focus.

6. Hit the relevant key at the time you want the drum played.
Getting the rhythm right might take a little bit of practice, since a computer 
keyboard wasn’t really designed for playing drums.

7. Keep playback going and add as many notes as you like.

● Please be aware that the latency phenomenon (see page 155) applies to tap 
recording as well. If your system has a large latency, you will need to hit the 
keys slightly in advance.

ÍZXCVBNM,./Í
ÒASDFGHJKL;'\

-
SDBD CP CY OH CHCBRSHTMTLT

MACLHCMCLC

AC
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Deleting notes via the Computer Keyboard
You can also delete notes from the computer keyboard:

1. Select the drum instrument you want to delete, using the rotary knob or 
the name labels.

2. With playback activated, press and hold the [Shift] key, when the notes 
you want to delete are playing.
Notes get deleted for as long as you keep the [Shift] key pressed.
- 27 - 
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Working with Shared Instruments
There are 16 sounds to select from, plus the Accent (see page 29). However, there 
are only 11 sound slots (not counting the Accent), that is, you can only have up 
11 sounds playing at any time (techniques for extending the number of sounds
in a Song can be found on page 28).

An example of a “shared instrument” is Low Tom (LT) and Low Conga (LC). Y
can only have either Low Tom or Low Conga in one Pattern.

Selecting “Shared” Sounds

To select one of the two sounds in a shared “slot”, proceed as follows:

1. Select the basic sound in the pair, using the rotary knob.

2. Flick the switch on the panel that selects between the two sounds in a 
shared slot.

You can flip the shared instruments switches at any time, even after program-
ming a sound. The Pattern will then play back with the newly selected sound, 
rather than the other.

Using Song Mode to play two Shared Instruments in one Song

● If you are not familiar with Song mode, the text below might not make sense 
to you. Please get back to this section once you have acquainted yourself with 
Song automation.

The settings of the shared instrument switches are part of the Song automatio
most other controls on the panel. This means that a Pattern programmed with 
might be played back with Congas, if that is the way the switches are set in the Song. 
While this might be confusing at first, it can also be used to good effect. You 
program sound changes as part of your song automation, and therefore have
(for example) Toms and Congas in one Song. See page 64 for more information.

These switches selects 
between two sounds in a 
pair.
- 28 - 
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Working with Accents
The sound to the far left on the Panel is labelled AC, for accent. This is not a d
sound as such, but rather a way to control the dynamics for a Pattern. Steps 
an Accent is programmed will be louder than other steps. The effect is global fo
sounds, that is, they will all be louder by the same amount.

1. Select the Accent Instrument.

2. Add an Accent to steps you want to be louder.

3. Adjust the Accent volume knob, to set the difference in volume between 
accented and un-accented steps.

Accent is most often used for adding “life” to a rhythm part. To check out the e
fect, try this example:

1. Program a simple Pattern that plays a closed hi-hat on all sixteenth notes.

2. Add accents to every other step, that is step 1, 3, 5, 7 etc.

3. Adjust the Accent level.

About Open and Closed Hi-hat
Open hi-hat (OH) and closed hi-hat (CH) are mutually exclusive. That is, only 
of them can sound at a time. Here are the rules:

• If you program an open hi-hat on one step, and a closed on the next, the 
closed hi-hat will cut off the sound of the open hi-hat.

• If you program open and closed hi-hat on the same step, you will get a 
very short open hi-hat sound, that sounds very much like a closed hi-hat.
- 29 - 
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Clearing the Pattern
If you wish to clear the Pattern, proceed as follows:

1. Move the focus bar to the rhythm section, either by clicking between the 
Pattern selector and the actual “drum machine”, or by using the up/down 
keys on the computer keyboard.
Either way, you want the orange indicator to be in the rhythm section.

Focus set to the rhythm section.

2. Select Clear from the Edit menu.
The Pattern is cleared.

Working with Various Pattern Lengths
By default all Patterns are one bar long, that is they are made up of sixteen sixt
note steps. However, you can shorten a Pattern to any number of sixteenth n
between 1 and 16. This allows you to program rhythms in unusual time signa

• To set the Pattern length, use the Length indicator arrow buttons.

The Pattern Length setting.

This operation can be performed at any time, whether the Pattern is empty or
and both in playback and stop mode. The change takes effect immediately.
- 30 - 
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Sound Parameters

The rhythm section sound parameters.

Each individual sound has one or more parameters for adjustment of sound c
ter and level. Every sound has a level control and many sounds have addition
rameters. Below follows a summary of the available parameters:

Level
This is simply the volume for the sound.

Tune
This is the pitch of the sound, the tuning. For the snare, please note that this 
affects the “body” of the sound, not the “rattle”.

Tone
This is like a tone control, a “filter” that adjusts the timbre. The higher the sett
the brighter the sound.

Decay
This adjusts the length of the sound.

Snappy
This is only available for the snare. It adjusts the balance between the “body” o
sound and the “rattle”.
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Preparations
1. If required, create a New song or Open an existing one.

2. Make sure Pattern mode is selected.
This is done using the Song/Pattern switch on the Transport panel. You can 
only program Patterns in Pattern mode.

3. Select a Pattern to program.
How to do this is described on page 18. 

The Pattern you select can be an empty one or one already playing somethin
doesn’t matter. If it is filled with notes you can either clear it to start over from
scratch, or modify the existing Pattern as you like.

Soloing a Synth Section
If you want to make sure you are only hearing one of the synths while programm
you will want to turn off all other sections:

• Click the on/off button in the mixer for the rhythm section and the other 
synth, to turn them off.

In this example you will only hear the upper synth.

Programming and Playback
You can program synth Patterns, whether the program is in stop mode or playi
doesn’t really matter which, but the most convenient is probably to have playb
going so that you will hear the notes you have programmed so far as the Patt
peats.
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Clearing the Pattern
In a new default Song document, all Patterns are already programmed. You m
want to clear the Pattern before you start, using Clear on the Edit menu. For 
info, see page 40.

Basic Procedures
Basically, creating a Pattern is a question of selecting each of the sixteenth n
steps, and making settings for each one. These settings determine whether e
the steps plays a note or a pause, what the pitch should be etc.

Here’s a step by step instruction for the basic method of making a Pattern:

1. Make sure you are not in Pitch mode. If the Pitch mode light is lit, click 
on it to turn it off.
See page 36 for more information on Pitch mode.

Pitch mode deactivated.

2. Use the Step and Back buttons to move to the step you want to make 
changes for.
The step counter shows you where in the Pattern “you are”.

The step counter.

● If you want to move to step one, there’s a shortcut: Click on the Pitch mode 
button twice.
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3. Adjust the settings for each step, as desired.
Below follows a quick description of the possibilities, details about each one 
follows later in this chapter.

4. Use the Step button to move to the next step, and make settings for this.
If you are already at the last step, this button takes you to the first step in the 
Pattern.

5. If required, use the Back button to step back through the steps and adjust 
the settings as needed.
If you’re at the first step, this button takes you to the last step.

6. Repeat steps 2 to 5 above for the remaining steps until the Pattern plays 
as desired.

This determines whether the 
current step plays or not.

Determines whether this step should be 
played with an accent (louder and with a 
different character).

The pitch for the step.

These allow you to trans-
pose the note up or down.

Decides if the 
pitch of this step 
should slide over 
to the pitch of the 
next step.
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Using Pitch Mode
When Pitch mode is activated, the programming procedure is slightly differen
this mode, as soon as you select a pitch on the keyboard, the program automa
advances to the next step. This can be used for two things, for programming 
tern quickly from scratch, and for altering the pitches in an existing Pattern.

Programming a Pattern from Scratch in Pitch Mode

1. Set up an empty Pattern and make sure you are at the first step.
Check the step counter if you are unsure.

2. Activate Pitch mode.

Pitch mode activated.

3. For the first step, set the note/pause, octave, accent and slide switches as 
desired.

4. Select a pitch for the step by clicking the keyboard, and the program au-
tomatically advances to the next step.
Note that selecting the pitch should be the last thing you do, since the pro-
gram then advances to the next step.

5. Repeat steps 3 to 4 until the Pattern is finished.

Changing the Pitches in an Existing Pattern

Pitch Mode is extremely useful if you have a Pattern with the correct rhythmic
phrasing etc, but want to use it in different places in the song, with other pitches
example to fit different chord progressions).

1. Select the Pattern and make sure you are at the desired step, probably the 
first.

2. Activate Pitch mode.

3. Select a new pitch for the step by clicking the keyboard, and the program 
automatically advances to the next step.

4. Repeat until the Pattern is finished.

If you have a step where the pitch is already correct, you can instead just clic
Step button to advance to the next step.
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Using the Keyboard for Creating and Editing Patterns
There are computer keyboard equivalents for all the step settings. On the nex
there is a diagram of these. We strongly recommend you to take some time t
acquainted with using the keyboard, it is a much faster way of programming P
terns than using the mouse, once you get used to it.

Switching Keyboard Input to Synth programming

On the Options menu, you will find a switch for what the keyboard is used for.
use the keyboard for synth Pattern editing, set it to “Program Synth from Key-
board”.

Setting the focus to the correct section

Since there are two synthesizer sections, you must also make sure that your 
board input is routed to the correct one. This is done by moving the focus bar to
section (see page 19). This is done by clicking in the relevant section or by using t
cursor up/down keys.

In this example, the focus is set to a synth section.

The keys used for editing synth Patterns. The illustration shows a US keyboard. Note that the keys are on 
the positions indicated, regardless of which letters are printed on the keys in your particular country.

CVBNM,./Í

4567890-=ı
RTYUIOP[]
DFGHJKL;'\

Back

Step

Note/Pause

Accent
Slide

Octave Up
Octave DownPitch keys
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Tapping the Rhythm

Tapping can be used for defining a rhythm for a synth pattern. The way this w
is that when you tap, that step is set to Note (as opposed to Pause) regardles
previous state. That is, tapping only adds notes, it never deletes them.

1. Set up a Rhythm Pattern so that you have something to go by.

2. If you like, clear the synth Pattern before you start tapping.

3. Make sure “Program Synth from Keyboard” is activated on the Options 
menu.

4. Activate playback.

5. Make sure the desired synth section has the focus.
See page 19 for more info on focus.

6. Hit the [Tab] key at the time you want to add a note.
It will play back on the next lap, at whatever pitch as programmed for that 
step.

7. Keep playback going and add as many notes as you like.

● Please be aware that the latency phenomenon (see page 155) applies to tap 
recording as well. If your system has a large latency, you will need to hit the 
keys slightly in advance.

Deleting Notes

You can also delete notes using the computer keyboard. Technically this mea
switching the steps from Note to Pause mode.

• With playback activated, press and hold the [Shift] key, when the notes 
you want to “delete” are playing.
Notes get switched to Pause mode for as long as you keep the [Shift] key 
pressed.
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Working with Octave settings
The Octave settings transpose a step one octave up/down. This gives you a to
tave range of three octaves, from the lowest C transposed down to the highe
transposed up (not counting the tuning parameter, see page 42).

● You can activate both octave switches at the same time, but this is the same as 
having no transposition at all.

Working with Accents
When Accent is activated for a step, the step will be louder, different in sound 
acter and the note will be shorter. Exactly how different it will be is determined
the Accent knob setting.

If the Accent knob is all the way down, notes with Accent will only be shorter.

Working with Slide
When Slide is activated for a step, the note will be tied to the next and the pitch
continuously “glide” to the pitch of the following step.

● Please note that Slide should be activated on the note you slide from, and not 
the note you slide to.

There are a few special cases you should be aware of:

Sliding from a Pause

If a step is set to pause it won’t sound. However, if Slide is activated for that s
step, the next note will still slide in to the right pitch. The slide will start at the pitch 
set for the silent step and end at the pitch of the next step.

Several Sliding Notes after each other

If you have several sliding notes, one after the other, they will all be tied togeth
one long legato phrase. This can be used to good effect to create “wavy” or p
bend effects.

The Accent button activates 
Accent for the current step...

...while the Accent knob sets the 
amount for all “accented” steps.
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Sliding to Notes with the same Pitch – Long Notes

If two or more notes are tied together with the slide feature, but they all have 
same pitch, the result will be one long note. This is how to create longer note
(eighth notes, quarter notes etc).

Sliding and Accents

Among other things, the accent affects the envelope – the device that shapes
sound over time. However, if a note is sliding from previous notes, and you ad
cent for one ore more steps, the exact effect of the Accent depends on a num
parameters. Sometimes the Accent has less effect on sliding notes. Experime
get the hang of it!

Clearing the Pattern
If you wish to clear the Pattern, proceed as follows:

1. Move the focus bar to the desired synth section, either by clicking be-
tween the Pattern selector on the actual ‘synth panel’, or by using the up 
and down keys on the computer keyboard.
Either way, you want the orange indicator to be in the synth section you want 
to clear.

2. Select Clear from the Edit menu.
The Pattern is cleared.

Working with Various Pattern Lengths
By default all Patterns are one bar long, that is they are made up of sixteen sixt
note steps. However, you can shorten a Pattern to any number of sixteenth n
between 1 and 16. This allows you to program rhythms in different time signat

• To set the Pattern length, use the Length indicator arrow buttons.

The Pattern Length setting.

This operation can be performed whether the Pattern is empty or not, and bo
playback and stop mode. The change takes effect immediately.
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The Synth sound controls.

Waveform
This allows you to select between two waveforms for the synth oscillator:

Tune
This sets the tuning of this synth section. The range is ±1 octaves in steps of semi-
tones. This control can be used for matching the pitch of Patterns programme
different keys, for real time transposition and for effects.

● Please note that there is also a Transpose function (on the Edit menu), that al-
lows you to alter all notes in a Pattern (in steps of semi-tones) to fit a particular 
key.

Cutoff
This is the overall filter setting for the sound. The higher the setting, the ‘brigh
the sound. This setting interacts with Envelope Modulation as described in mo
tail under the Envelope Modulation heading later in this chapter.

Resonance
This is another control for the overall character of the sound. Technically it ro
the sound at the output of the filter back to the input, in a feedback loop. Sound
it gives the sound a more hollow, pronounced character. Together with envel
modulation, slide and accent (see page 53), it is largely responsible for the 303 
sound character. To try this out, turn the resonance all the way up, and twist th
off and Envelope Modulation knobs.

Symbol: Name: Description:

Sawtooth This is a full and rich waveform where all harmonics are in-
cluded.

Square This waveform only contains odd harmonics, which gives 
the sound a more “hollow” quality.
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Env. Mod. (Envelope Modulation)
This adjusts the way the envelope affects the cutoff frequency. Let’s describe
in more detail:

As described above, the cutoff setting is a basic tonal setting for the filter. In a
tion to this there is the envelope, which makes the cutoff frequency vary as the no
decays. This is the way many “real” instruments work, as the sound decays it
gets less bright. The envelope simulates this by making the cutoff frequency co
uously lower as the sound decays. How fast this decay actually occurs is set 
the Decay knob, see below.

• In its lowest position, the envelope has little effect on the sound.

• At higher values, the envelope makes the filter open further, that is the 
sound will be brighter.

Decay
This adjusts the length of the envelope, to make notes decay faster or slower

Accent
This knob is used for setting to what extent the steps with Accent activated sh
be different from the other steps. The setting does not only affect volume, but
the shape and character of the sound.
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● To have access to the functions described in this chapter, you must be in Pat-
tern mode, not in Song mode!

Cut, Copy and Paste (Pattern)
These functions allow you to move and copy Patterns between Pattern locati
You can cut, copy and paste within one Song document, or between two Son
uments. Proceed as follows:

1. Set the focus to the section you want to cut or copy from.
See page 19 for details about the focus.

2. Select the Pattern you want to cut or copy.

3. If you want to move the Pattern to a new location, select Cut from the 
Edit menu. If you want to make a copy of it, instead select Copy.

4. If you want to paste into another Song, click on its window, so that it be-
comes active.

5. Move the focus to the section where you want to paste the Pattern you 
just cut/copied.
If you want to Paste it in the same section, this step is not required.

6. Select the Pattern location where you want to paste.

● Note that when you select Paste, the Pattern that was currently in this location, 
will be overwritten and can not be retrieved.

7. Select Paste from the Edit menu.
The Pattern you cut or copied is pasted in at the selected Pattern location.

● You can not paste Synth Patterns into the Rhythm Section and vice versa.
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Pattern Functions
There are a number of menu functions that allow you to perform various type
editing to your Patterns.

Selecting the Pattern to be Affected

Any of the functions described above always operate on one Pattern in one se
Before you use the function you must make sure the right Pattern will be affe

Please proceed as follows:

1. Set the focus to the correct section.
See page 19 for details about the focus.

2. Select the Pattern you want to be affected.

3. Select the function from the Edit menu.

About Multiple Menu items

Some functions appear more than once, depending on the various options. T
available items might also vary with the focus. If the rhythm section has the fo
other options are available than if a synth section has a focus. Let’s take Shift 
example of this:

• If a synth has the focus, there will be two Shift items: Shift Pattern Left and 
Shift Pattern Right.

• If the rhythm section has the focus there will be four Shift items: Shift Pat-
tern Left, Shift Pattern Right, Shift Drum Left and Shift Drum Right.

Clear

To clear a Pattern completely, use this function.

• For the rhythm section, this will deactivate all steps for all instruments.

• For the synth sections, this will set all steps to pause (as opposed to 
note), no accent, to the pitch C, no slide, and no octave transposition.
In both cases, this means the Pattern will be silent after the operation.
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Shift Pattern/Drum Left/Right

This function moves the notes in your Patterns “left” or “right”. It either acts on 
whole Pattern (Shift Pattern Left/Right), or – for rhythm Patterns – it can be u
for shifting the selected drum instrument only (Shift Drum Left/Right).

If you for example use Shift Pattern Right on a synth Pattern, notes that were
step 1 will be moved to step 2, notes that were on step 2 will be on step 3, and 
up to the notes on the last step which will be moved to the first.

This function can be used for interesting rhythmic effects. It can sometimes als
used as a rescue. If, for example, you have created a great synth Pattern but 
that the downbeat as you hear it, is not on the fist step, use this function to re
the situation. To move the Pattern several steps, simply use the function repe

● This function does not take Pattern length into consideration. It always oper-
ates on all 16 steps.

Random Pattern/Pitches/Accents etc./Drum

These functions can be used for creating a completely new Pattern, or to only
omize certain aspects of it.

Use this is as a way to generate music automatically, or as an inspirational too
terns that are generated in this way can be edited as any other, so if you don’t
the result is exactly what you need you can change it in whatever way you req

Option Description

Random Pattern Creates a complete Pattern with random pitches, accents, 
slides etc.

Random Pitches Randomizes the pitches of the Pattern without changing 
anything else.

Random Accents etc. Randomizes the Note/Pause, Accent, Slide and Octave set-
tings for the steps.

Random Drum Randomizes the programming for the selected rhythm in-
strument.
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Alter Pattern/Pitches/Accents etc./Drum

This alters existing synth and rhythm Patterns, by randomly shuffling the data 
existing Pattern. Note that there must be some material to alter for this functio
work. In other words, applying it to an empty Pattern will leave you with an em
Pattern.

If you want to create a pseudo-randomized Pattern that stays within certain mu
boundaries, try the following:

1. Activate Pitch Mode in a synth section.

2. Play the notes you want included in the Pattern, in no particular order.

3. Deactivate Pitch Mode.

4. Select Alter Pattern or Alter Pitches.

● This function does not take Pattern length into consideration. It always oper-
ates on all 16 steps.

Transpose

This function allows you to change the pitch of the notes so that the Pattern fi
other key. The dialog box that appears allows you to specify the number of st
you want to transpose up/down (±12 semitones).

The transpose dialog. (Macintosh version).

● Please note that there’s a limitation to how much you can transpose notes. If 
they already have very high pitches, they might be moved one octave in either 
direction, so that they “appear” within the valid range of pitches.

Option Description

Alter Pattern Alters all aspects of the Pattern.

Alter Pitches Alters the pitches.

Alter Accents etc. Alters the Note/Pause, Accent, Slide and Octave settings.

Alter Drum Alters the rhythm of the selected instrument.
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Introduction
This chapter describes how to use the various features used for creating a fin
of the sounds: levels (volumes), panning and effects.

The effects in ReBirth RB-338 consist of a distortion unit a delay and the PCF 
tern Controlled Filter). These work just like their physical counterparts, you con
them in the signal chain and make settings for intensity and other characters 
effect.

ReBirth RB-338 signal flow diagram.
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LEVEL

DIST INSERT
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DDL SEND

VU

LEVEL PAN

DDL SEND
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LEVEL PAN

DDL SEND
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Synth 2
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PCF INSERT
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H
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Setting Levels

Section Levels

Each of the three sections has a level control, the slider. This is used for adju
the balance of this section against the others. Here are some guidelines for s
levels:

• Don’t worry about cranking a section all the way up. Any distortion (clip-
ping) that occurs can always be removed with the Master Level control, 
see page 21.

• To get the lowest amount of noise, keep the levels up as much as possible 
at all times. For example, set the loudest section to play at full level and 
adjust the other levels downwards to this, to get the right balance.

Master Level and Meter

The Master level and meter.

This is used for adjusting the overall level from ReBirth RB-338. It is also used
compensating for any clipping that occurs on the output, due to loud levels from
three sections and the effects. Again, see page 21.

● The Master level setting is not part of the Song automation!

The section levels are 
located in the Mixers.
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Muting

In each mixer there’s an on/off setting, a mute function. This is used for tempor
silencing the audio from a section.

● This setting is not part of the Song automation. To incorporate silent parts in 
the Song, use the Pattern on/off switches instead, see page 64.

Using Pan

Panning allows you to position a section anywhere in the stereo image. There
several uses for this:

• To increase separation between the three sections, by giving them differ-
ent stereo positions.

• To create interesting effects by panning a section one way and adding a 
delay to it, panned the other way.

• To pan sections fully hard/left to use the stereo output as two separate out-
puts. You can then get total separation of sections when recording to other 
media or using external effects.

• Using the Song automation you can create sounds that move “automati-
cally” across the stereo image.

A Mixer...
...muted...
...unmuted.

The Pan controls 
are located in the 
Mixers
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Dist (Distortion)

The Distortion section.

Distortion makes the sound dirtier and grungier, like when you turn up the vol
on a guitar amplifier. The distortion in ReBirth RB-338 is an insert effect. This
means it will be inserted into the signal, just after the output of one of the sect
Only one section at a time can be distorted.

Trying out the Distortion

1. Activate playback, in Pattern mode.

2. Make sure only one of the synthesizers sound, by using the Mute buttons 
in its mixer.

3. Active the Dist in that synth’s mixer, by clicking the switch so that it 
lights up.

4. Activate the Distortion, by clicking the on/off button in the Dist section.

5. Raise the Amount switch in the Dist section to about one o’clock.

6. Check the sound with and without distortion by clicking the on/off but-
ton in the Dist section. Also check the Distortion effect at various cutoff 
and resonance settings.

Routing

To decide which section will use the distortion, you use the Dist switches.

• Only one section at a time can have Dist activated.

• You can turn Dist off for all sections, should you wish.

Distortion 
on/off

Distortion 
Amount

This section has
Distortion activated.
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Activating/Deactivating

Once you have decided which section will use the Dist effect, you need to act
the effect itself. This is done in the Dist section by clicking the on/off button.

• When this is on, one of the sections will pass through the Distortion ef-
fect.

• When this is deactivated, no sound will pass through the distortion effect 
(bypass).

The Amount Setting

There is only one setting for the distortion, Amount. The higher this setting, the
ier the sound.
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Delay

The Delay section.

Delay adds echoes, or repeats, to the sound. The Delay effect in ReBirth RB-3
a send effect, which means is can be utilized by all the sections, by variable 
amounts. In addition, the Delay appears after the distortion in the signal chain
other words, the sound will first get distorted and then pass through the delay
Please refer to the signal flow diagram on page 50.

Trying out the Delay

1. Make sure only one of the synthesizers sound, by using the Mute buttons 
in the mixer.

2. Select a pretty simple synthesizer Pattern and activate playback, in Pat-
tern mode.

3. Raise the Delay setting in that synth’s mixer, to about two o’clock.

4. Activate the Delay, by clicking the on/off button in the Delay section.

5. Set the delay controls as the picture below indicates:
This will give you a basic delay with a length of three sixteenth notes with ap-
proximately three repeats.

Delay example.

Delay on/off

Feedback (number
of repeats)

Delay Length (sixteenths 
or eighth note triplets)

The panning of the 
output from the delay

Sixteenth note/eighth 
note triplet switch
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The Delay Amount Setting

The Delay knob in each section is used for determining how much of the signal
this section that should be “fed” into the delay unit.

• If you set this all the way down, no delay will be added to this section.

• If you raise it all the way up, the first repeat from the delay will have the 
same level as the original signal.

Activating/Deactivating

In addition to setting the Delay level for each section, you need to activate the D
section itself. This is done by using the on/off switch in the Delay section on t
front panel.

The Delay Settings

Setting: Description:

Number of sixteenth notes 
(Steps)

This is the length of the delay. The shortest setting is 
one sixteenth note, the longest is 32 eighth note trip-
lets (see below).

Straight notes/Triplets This allows you to switch between repeats at eighth 
note triplets and straight sixteenth notes.

Feedback This is used for setting the number of repeats, by ad-
justing how much of the signal from the output of the 
delay is fed back into the input. When this is all the 
way down, there will only be one repeat. When it is all 
the way up, there will be an infinite number of repeats, 
which means the delay will keep sounding even if you 
stop playback.

Pan This is used for setting where in there stereo image the 
delay signal will appear. For example, you might pan 
the sound from some section to the left and the delay 
right, to get a stereo effect.

This section has
Delay added.
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The PCF (Pattern Controlled Filter)

Introduction

The PCF is an extremely versatile synth effect. It allows you to change the so
from any of the sections in ReBirth RB-338, in a number of ways.

Basically, the PCF is a filter with an envelope, just like there are filters with en
lopes in the synth sections. You route the output of one of the sections throug
PCF and thereby shape the tonal character of the sound.

The main difference between the PCF and the synth filters is that this filter is 
tern controlled”. There are a large number of preset patterns that allow the filt
“superimpose” pumping effects, slow sweeps and rhythmic phrasing onto the
sound. But before we go into the technical details, let us give you an example
how the PCF can be used. 

Trying out the PCF

1. Make sure you are in Pattern mode.

2. Create a simple rhythm Pattern to use as a guide.

3. Create a synth Pattern that only plays one long droning note.
One way to do this is as follows: Clear a Pattern, step through it, activating 
Slide for each step, and switch each step from Pause to Note.

4. Mute the other synth section.

5. Turn off Delay and Distortion.

6. Play back to make sure you hear the long note with a basic sound (set 
Cutoff at two o’clock). Leave playback on.

7. In the Mixer section of the synth you are listening to, click on the PCF 
button, so that it lights up.

8. Activate the PCF by clicking in its upper left corner, so that the LED lights 
up.

9. In the PCF, select Pattern “5” and set the filter type switch to BP. Then set 
up the faders approximately as in the picture below.
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You will now hear a repeating effect occurring on quarter notes. What happen
that the filter envelope is being retriggered on quarter notes.

10.Step through PCF Patterns 0 to 11 and listen to the various rhythmic fig-
ures.

11.Before you test Pattern 12 to 21, raise the Decay and Q settings as the 
picture below indicates.

You will hear that Pattern 12 to 21 more or less imitate filter “sweeps”, rather t
repeat effects.

12.Set the controls back as they were before, and test Patterns 22 to 33.
These Patterns are more complex, they contain various rhythmic figures in-
cluding dynamic changes and various time signatures.

13.Finally, test the Patterns above 33.
These are triggering on 32nd notes, rather than on sixteenth notes.

14.Experiment with various settings and apply the PCF to other Patterns 
than the one you have now.

15.Mute the synth you are hearing.

16.In the Rhythm section Mixer, click on the PCF button, so that it lights up.
You will note that the LED goes out for the synth, since only one section at a 
time can use the PCF.

17.Experiment with various settings in the PCF section.
You will notice that it is quite simple to create really interesting electronic 
sounding drum sounds.

To find out more about the various controls and the technical details, read on
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How the PCF Works - Background Information

The PCF is built from two major components:

1. The Filter

This is a 12dB/octave (2-pole) design that can be switched between lowpass 
bandpass operation and has cutoff and resonance controls.

2. An Envelope with Patterns

This is a simple Attack/Decay envelope. The Decay time can be set on the PC
panel. The Attack is controlled via the Patterns, as described below. By using
AMT (Amount) control on the PCF panel, you can set to what extent the enve
affects the filter.

Block diagram of the PCF.

Envelope section

Q

Decay

Pattern

Filter section

ModeLP BP

Amt Freq
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About the Patterns

There are a large number of preset patterns that provide various rhythmic effe
They do this by controlling the following envelope parameters:

• Retriggering
This is the most basic type of control. In Pattern 0 for example the envelope is 
retriggered (restarted) at each whole note, in pattern 1 on each half note etc.

• Dynamic and Attack control.
In many of the Patterns, the envelope is triggered with different dynamics on 
different “beats”. Some “beats” also have a different attack.

The Patterns are preset, they can not be changed. Their length vary, most are
two bars, but some have been created in odd time signatures (a full list can be
on page 179 and onwards).

Routing

To decide which section will use the Pattern Controlled Filter, you use the PC
switches in the Mixers.

• The PCF comes after the Distortion, in the signal chain.
That is, if you activate both distortion and PCF for a section, it passes through 
the distortion first and then the PCF.

• Only one section at a time can have PCF activated.

• You can of course turn the PCF off for all sections.

Activating/Deactivating

Once you have decided which section will use the PCF effect, you need to ac
the effect itself. This is done in the PCF section by clicking the on/off button.

• When this is on, one of the sections will pass through the Pattern Con-
trolled Filter.

• When this is deactivated, no sound will pass through the Pattern Control-
led Filter (bypass).

This section has
PCF activated.
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The PCF Settings

Pattern

The patterns are roughly divided into the following categories:

See page 179 for diagrams of the various patterns.

Mode (BP/LP)

This switches the filter between its two major modes, lowpass and bandpass.

• The lowpass filter (LP) is similar to the one used in the synth sections in 
ReBirth. It lets all harmonics below a certain frequency (the cutoff fre-
quency) pass through.

• The bandpass filter (BP) only lets frequencies within a certain band (a 
range of frequencies) pass through.

Freq (Frequency)

This is the main frequency range the filter should operate in.

The Freq parameter is related to the Amount (Amt) parameter:

• If the Amount slider is set to zero, there will be no pattern effect at all. The 
filter can then be used as a fixed “tone control” by adjusting the Freq and 
Q parameters.

• If the Freq slider is all the way up, the Amt slider has no effect since the fil-
ter is already fully open.

Pattern 
number

Description

0 to 5 Even rhythms, no dynamics. 

6 to 11 Simple rhythms, no dynamics. 

12 to 17 Simple sweeps, slow dynamics. Try these with long decay 
times! 

18 to 21 Complex sweeps (more or less random). 

22 to 33 Complex rhythms with dynamics and varying attacks. 

34 to 45 32nd note patterns.
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This is the same as the “Reso” control in the synth sections. Technically it rou
the sound at the output of the filter back to the input, in a feedback loop. Sound
it gives the sound a more hollow, pronounced character.

● Be careful when combining large Q values in the PCF with large Reso values 
in a synth, since this might lead to overloading the output of the PCF, causing 
distortion.

Amt (Amount)

This control determines the amount of effect the envelope has on the filter. Fo
Pattern effect at all, this must be set to some value above zero.

Dec

This adjusts the length of the envelope decay. This has a significant effect on
“feel” of the Pattern.

• At low values there will be a clear pumping effect.

• When the Decay is raised, the pattern effect will be “smeared”. This can 
be used to good effect with Patterns 12 to 17 for smooth “LFO” effects.

• At very high values, the envelope will not be given a chance to decay very 
much until it is retriggered, giving a “stepping” effect (similar to the old 
synth effect “sample and hold”). This is most noticeable on patterns with 
dynamics (12 and above).

The picture below shows the same Pattern with three different envelope settin

1 2 3 4 5 6 7 8
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Introduction
In Song mode you record series of Pattern changes and knob settings and m
ments, to create a complete Song. Practically all front panel control can be reco
You can create automation of filter sweeps, level changes, effect controls, etc

● The only controls that are not affected by automation are Tempo, the Mute 
buttons in the Mixer and the Master Level controls!

About the Song/Pattern Modes

The Song/Pattern mode switch.

The Song mode is drastically different from Pattern mode. Here are some of th
ferences you will encounter:

• Knobs and buttons are always automated.
In Song mode, settings and movement of panel controls are always under au-
tomation control. You can not move any controls when just playing a Song, 
you have to have Record activated to do this.

• Pattern selection is automated.
Again, what Patterns will play is determined by what is recorded in the Song, 
not any manual Pattern selections you make using the mouse or keyboard.

• You normally don’t perform Pattern editing in Song mode.
You can re-program the currently playing Pattern. However, since the Song 
might switch to another Pattern during playback, be careful so that you don’t 
re-program the wrong Pattern!
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Playing Songs
When you open a Song, it will play back just as recorded, together with all Pa
changes, panel settings and automation.

The following possibilities are available:

• You can use the Transport controls (see the printed documentation) to 
move to any position within the Song and start playback from there.

• The Song doesn’t really have an end. All Songs can be up to 500 measures 
in Length and playback will continue up to that point, unless you stop it 
before.

• You can set up and use the Loop to repeat a section, infinitely. If you 
want the whole Song to repeat over and over, set up the Loop to encom-
pass the whole piece.

• You can mute and unmute sections and adjust the master faders. These 
controls are not part of the Song automation.
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Preparations for Creating your own Songs

Pattern mode Preparations

1. In Pattern mode, create all the Patterns you want to use in the Song.
There’s actually nothing preventing you from switching back to Pattern mode 
at any time, to add and modify Patterns, but you probably want all the basic 
Patterns to be ready before you assemble the Song.

2. Try out the basic Pattern changes, to make sure everything works alright.
A good way to do this is to use the computer keyboard for Pattern switching, 
see page 194.

3. Set up a basic mix including all the sounds for the Song, even including 
effects.

4. Save your Song so you can go back to this stage later.

You are now done with the Pattern mode work. Let’s switch to Song mode.

Song Mode Preparations

1. Switch to Song Mode.

2. Select “Initialize Song from Pattern mode” from the Edit menu.

This accomplishes two things:

• The whole Song is completely cleared.

• The entire Song is set up so that it plays exactly like Pattern mode, just 
before you switched over to Song mode.
This includes the control (knob) settings.
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Building a String of Patterns
When creating a Song you most likely will want to create the basic chain of Pat
first, and work on the levels, sounds and effects afterwards. To create the Pa
changes, proceed as follows:

Preparations

1. Follow the preparation steps outlined above, so that you have an empty 
Song to start from.

2. Turn off the Loop.
While this is not required, Loop recording introduces some new concepts, de-
scribed on page 74. Therefore, to get started with Song creation, turn the Loop 
off.

The Loop deactivated.

3. Rewind to the first step of the Song (bar counter says “1”).

4. Press the Record button so that it lights up.

5. Select the Patterns for the first bar, by clicking the corresponding Pattern 
selectors in the three sections.
From here on there are two ways to go: Step Mode writing and Real Time writ-
ing.

Real Time Writing of Pattern Changes

1. With Record mode still activated, activate Play.

2. Change Patterns as the Song plays back.
You can make changes in just one section, or in several, it doesn’t matter. 
Some people will feel confident using the mouse to create the changes for just 
one section at a time, others will use the keyboard to arrange the whole song 
on the fly, it’s all a matter of personal taste.

● Please check the special notes for creating an end for the Song, see below.

3. When you are done, hit Stop.

4. Rewind and play back to check.
If you made any mistakes, you can correct them now or later, as described be-
low. For now we will assume everything is OK, and that you will want to add 
Pattern changes for the other sections now.
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5. Rewind to the beginning of the Song.

6. Activate Record and Play and perform the changes for the next section.

7. Repeat as needed.

Step Mode Writing of Pattern Changes

If you prefer to “punch in a list” of the Pattern changes, without activating playba
proceed as follows:

1. Follow the steps under Preparations, above. Record mode should be acti-
vated.

2. While you are still at the first bar of the Song, make sure the correct Pat-
terns are selected for this step. If they’re not, select them.

3. Click on the up arrow in the Bar section, to advance to the next Bar.

The arrow buttons allow you to step through the bars in the Song, one bar at a time.

4. Select the Patterns that should play at this bar.
You only need to select actual Pattern changes. If a section should play the 
same Pattern as in the last measure, you don’t need to make any Pattern 
changes for this section.

5. Advance to the next Bar and select Patterns for this.

6. Repeat steps 4 and 5 as needed.

● Please check the special notes for creating an end for the Song, see below.

7. When you are done, hit Stop.

8. Rewind and play back to check.
If you made any mistakes, you can correct them now or later, see below.

Creating an “End” for the Song

A song is actually always 500 bars, it has no real end before that. Playback a
continues up until bar 500, unless you stop it. Furthermore, all measures in the
always play something. This has the effect that you must make sure that there a
enough silent measures at the end of the Song, for your purposes. If you only
say, four measures of silence at the end of a Song, and playback continues pas
four measures, the Song will play back any Pattern combination that happened
stored at the remaining measures. To avoid this, add a healthy number of silen
sure after your Song end:
- 68 - 



1. Set the start of the Loop to the position of the first bar that should be si-
lent.

2. Set the Length of the Loop to maximum value.

3. Activate Recording.

4. Either select silent Patterns or deactivate Pattern playback completely, in 
the Pattern sections.

A deactivated Pattern section.

● Do not use the level faders in the mixers for this purpose, it might lead to con-
fusing results, unless you are absolutely sure of what you are doing.

5. Select “Copy touched controls to Loop” from the Edit menu.

6. Deactivate Recording.
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Correcting Mistakes and Making changes to the Pattern 
Order

Starting Over

If you realize you would rather start over completely, you can always use the 
tialize Song from Pattern mode” command at any time, to clear the Song com
ly.

Making Changes to some Part of the Song – “Punching In and Out”

If some Pattern change is not as you’d like it to be, proceed as follows:

1. Move to the position of the first bar where you want to change Patterns.

2. Activate Recording.
You can make changes in Step or Real Time (Play) mode, technically it doesn’t 
matter. However, since in Play mode it can be tricky to deactivate recording at 
exactly the right point in, you might want to perform changes like this in step 
mode.

3. Proceed in Step mode or Real Time (Play) mode and select Patterns for all 
the relevant measures.

● As soon as you make Pattern selections in one section, that section is consid-
ered “punched in” and will show and play the currently selected Pattern, not 
the Pattern changes previously recorded! Also, don’t touch any other controls 
than the Pattern selectors, or you will have “punched in” on those too!

4. When you are at the last bar where you want to make any changes, make 
those changes and then deactivate recording.

5. Rewind and check.
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Recording Control (knob) Changes
Once you have your Pattern changes down, it is time to record all the front pa
controls. Use this to “mix” the Song (volumes, panning and effects) and to se
sound for the synth and rhythm sections (any sound parameter).

Real Time Recording

1. Make sure you are in Song mode. You will probably also want to make 
sure that all Pattern changes are as you want them.

2. Turn off the Loop.
While this is not required, Loop recording introduces some new concepts, de-
scribed on page 74. Therefore, to get started with control recording, turn the 
Loop off.

3. Rewind so that you are sure you are at the first step of the Song (bar 
counter says “1”).

4. Press the Record button so that it lights up.

5. Activate Play.

6. Move the controls as the Song plays back.
You can make changes to just one control, or to several, it doesn’t matter. Also 
note that you can move the controls via MIDI, as described on page 104.

7. When you are done, hit Stop.

8. Rewind and play back to check.
If you made any mistakes, you can correct them now or later, as described be-
low. For now we will assume everything is OK, and that you will want to add 
changes for other controls now.

9. Rewind to the beginning of the Song.

10.Activate Record and Play and perform the changes for the next con-
trol(s).

11.Repeat steps 9 and 10, as needed.

Recording in Stop Mode

You can record control changes in Stop mode. However, the settings you mak
when recording is activated in stop mode will only appear for a very short time,
at the beginning of that measure. For the remaining part of the measure, the 
will play whatever control changes were recorded in real time.
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Correcting Mistakes and Making Changes to Control 
(knob) Recordings

Punching In and Out – Making Changes to some Part of the Song

If some control recording is not as you’d like it to be, proceed as follows:

1. Move to a position one or a few bars before the mistake.

2. Activate Recording and playback.
Nothing gets recorded until you actually “touch” a control.

3. When you are at the right position, press the mouse button with the 
pointer over the control you want to record, and start moving it. Perform 
the recording.

● As soon as you “touch” a control in this way, that control is considered 
“punched in” and will from now on be showing and playing it’s current set-
ting, rather than the settings recorded in the Song. However, this happens in-
dividually for each control, controls that you haven’t touched during this 
recording pass are not affected in any way.

4. When you reach the Song position where you want to return to the previ-
ously recorded changes, hit Stop or deactivate Recording (by clicking the 
Record button or by pressing [*] on the numeric key pad).

5. Rewind and check.

6. Repeat steps 1 to 4, as desired.

Filling Measures with “Static” Control Settings

There might be situations where you want to make a “static” change to a numb
bars. You might for example want to lower the volume for the first synth betw
bars 13 and 21, or make sure the dist Amount is constant throughout the entire
Proceed as follows:

1. If you want to perform this action for just a section of the Song, set up 
the Loop to encompass that section.

2. Activate Recording.

3. If you want to, also activate playback.
It is often convenient to make a change in playback mode, since you will then 
hear what you are doing! However, note that when you touch a control in this 
mode, you will also record that action. Then again, this might not matter since 
you will in a short while fill the measures in the Loop or in the whole Song, 
with new settings for the control you just touched!
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4. When you have the setting right, select “Copy touched controls to Loop/
Song” from the Edit menu.

5. Now, the current setting for the controls you have touched during this re-
cording pass, will be copied to all measures in the Loop/Song.

6. Deactivate Recording.

Using “Initialize Loop from Pattern Mode”

This item, on the Edit menu, is used for ”initializing” the measures inside the Lo
This can be used as a convenient way to use the settings currently in Pattern 
as initial settings for some measures in the Song you are building.

● Please note that this command clears all the Pattern changes and knob record-
ings currently inside the Loop!

Proceed as follows:

1. Switch to Pattern mode and select the correct Patterns and set up all con-
trols as you want them to be inside the Loop. 

2. Switch back to Song mode and set up the Loop to encompass the meas-
ures you want to change.

3. Select “Initialize Loop from Pattern Mode” from the Edit menu,
All measures inside the Loop are filled with the settings currently made in Pat-
tern mode. That is, the three Patterns selected in Pattern mode will be used, as 
well as all knob and other control settings.
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Recording while Looping

A loop between bar 17 and 33.

All of the text above has assumed the Loop has been turned off. However, yo
also record in Loop mode. Basically this is the same as when you record with 
ing off, except for one situation: when you reach the position where the Loop s
over.

As described above, as soon as you touch a control, this is considered as “pu
in” for this recording pass, and will show and play the settings you give it now,
the ones previously recorded in the Song.

However, when you reach the loop end, all controls will be “punched out”, so 
on the next lap, they will instead play back movements recorded on the previou

● Please note that if the mouse button is still down when the Song reaches the 
end of the loop, it will be considered as “punched-in” again. That is, you will 
again be recording that control, which means you erase any actions per-
formed on previous laps.

To avoid this, release the mouse button just before you reach the Loop end.

About Recording Pattern changes vs. Control Changes
Actually there is no technical difference between recording Pattern changes a
controls.

The only reason we have described a working order of first creating the Patte
changes and then the control recordings, is because that is the way most peo
seem to prefer to work.

If you like, you can do things in any order. Record some Pattern changes, then
controls, then re-record the Pattern changes, for example. Whatever control r
ings you have made will now affect the new Patterns instead!

You can even start by recording the controls and then make the Pattern chan

Making Modifications to Patterns
First, to make modifications to the actual Patterns, we recommend that you s
over to Pattern mode.

Secondly, you should be aware that any changes you make to Patterns will im
diately be reflected in the Song. The Song always plays back the Patterns jus
they play in Pattern mode. In other words, what you record in the Song are swi
between Pattern numbers, not the actual Patterns themselves.
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Moving, Removing and Repeating Measures in the Song

Removing Measures

You may want to completely Remove some measures from the Song:

1. Set up the Loop to encompass the measures you want to remove.

2. Select Cut Loop from the Edit menu.
The measures are removed.

Cutting and Pasting Measures

If you want to move or duplicate some measures, proceed as follows:

1. Set up the Loop to encompass the measures you want to move/duplicate.

2. Select Cut Loop or Copy Loop from the Edit menu.
If you select Cut, the measures inside the Loop are removed and copied to the 
Clipboard, an “invisible” memory location from where they later can be 
Pasted. If you select Copy, the measures are only copied to the Clipboard.

3. Move the Song Position to the place where you want to Paste In the meas-
ures you just Cut/Copied.

4. Select Paste at Song Position or Paste Replace at Song Position.

The Difference between Paste and Paste Replace

• When you use “plain Paste”, the measures are inserted into the Song, so 
that is lengthened. 
If you for example have Cut four bars, and use “Paste at Song Position”, at 
Song Position 13, you will get four new measures between measure 13 and 
16. These contain the pasted material. Whatever was at bar 13 before the op-
eration, is now at bar 17.

• When you use “Paste Replace”, the Pasted material replaces whatever 
was at those measures before.
Again, if you Cut four bars, and use “Paste Replace at Song Position”, at Song 
Position 13, the contents of measures 13, 14, 15 and 16 will be replaced by 
the measures on the Clipboard.
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Repeating Measures

This is just a special case of Copy and Paste, as described above. If you are u
using Copy and Paste in for example a word processing program, you will see
this is the equivalent of that.

1. Set up the Loop to encompass the measures you want to repeat.

2. Select Copy Loop from the Edit menu.

3. Select Paste at Song Position as many times as you want the Copied meas-
ures to appear, after each other, in a repeated fashion.

How does the Repeat Procedure really work?

1. When you Copy the measures inside the Loop, the Song position is auto-
matically moved to the Start of the Loop.

2. When you Paste the first time, this means that what you Paste replaces 
the measures in the Loop with the measures on the Clipboard. However, 
since these are currently the same, you will notice no difference. But, 
when you Paste, the Song Position is automatically moved to the end of 
the Pasted section.

3. When you Paste again, the measures are inserted again, right after the 
previously Pasted section, and this goes on for as many times as you Paste 
without changing anything else in between.
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Using the Song Record Function in a “live” situation
In a live situation you might want to have “partial automation”. That is, you mi
want Pattern switching to be automatic, but control changes to be manual, or
versa.

To a achieve this, proceed as follows:

1. Create a Song that only contains the automation you want, for example 
only the Pattern switching.

2. Make sure the Song starts in the right way with all the correct Pattern 
and initial control settings.

3. Save the Song. Make a duplicate of the file for safety.

4. In the live situation, load up the Song, position to the beginning and acti-
vate Recording.

5. Hit Play and perform any Pattern switching or control changes you want 
to do live.

6. When the Song is finished, stop.

7. Close the file without saving.
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Why use ReBirth RB-338 with Cubase?
While ReBirth RB-338 is a complete music tool in its own right, you might wan
add other elements to the music, such as:

• Other synthesizers (controlled via MIDI).

• Samples and loops (via a sampler connected via MIDI).

• Vocals.

• Instrumental recordings.

And what better way to do it than to use ReBirth together with Steinberg’s ‘sta
the art’ audio sequencer, Cubase! Using this as a companion allows you to ex
and integrate your ReBirth Songs with any other type of music, MIDI and acou
recordings. By recording ReBirth onto audio Tracks in Cubase you can also a
more synth lines than is possible when using ReBirth by itself! For more info o
this, see page 101.

There are two ways to integrate the two programs: Synchronization (making t
two programs play at the same tempo) and audio sharing (using audio from b
applications on one computer).

For more background information on the concepts of synchronization see page 89. 
For more details about audio sharing, see page 100.

Synchronization

Cubase VST for Macintosh

● Before you create any serious projects that require sync, try out the features 
described below and check out “Synchronization Considerations” on page 
84.

ReBirth synchronizes to Cubase VST for Macintosh via OMS, the Open MIDI S
tem.

Setting Up Cubase

1. Install OMS on your computer.
OMS is included both with Cubase and ReBirth. Use whichever is the latest 
version.

2. When you install OMS, make sure that IAC gets installed properly.
This might require you to use the Custom install option. To verify, check the 
OMS folder in your System Folder, after installation. It should contain a file 
called “OMS IAC Driver”.
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3. Make sure you have an IAC symbol in your OMS Setup document.
If not, create a new Studio Setup, and when you’re asked whether you want to 
use IAC, activate that option.

4. Open the OMS MIDI Setup dialog in OMS Setup and make sure that “Run 
MIDI In Background” is enabled.

5. Quit OMS Setup.

6. In Cubase VST, pull down the File menu and select Preferences.

7. In this dialog, select “IN & OUT” from the OMS Compatibility menu.

Cubase set up to use OMS.

8. Quit Cubase and restart it.

9. On the Options menu, make sure “Play in Background” is activated.
If it isn’t, and you want it to always be, you should consider modifying your 
Autoload Song, see the section about Customizing in the Cubase manual for 
details.

10.Open the Synchronization dialog in Cubase.

11.In the Sync Out section, locate the MIDI Clock pop-up. Pull down the 
menu and select ”∞ IAC Bus #1”.
This routes the MIDI Clock Signals out to OMS from where ReBirth RB-338 
can receive them.

Cubase set up to transmit MIDI Clock to the IAC port.
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Setting Up ReBirth

1. In ReBirth, pull down the Edit menu and open the Preferences dialog.

2. In this dialog, pull down the Sync Input menu and select ”∞ IAC Bus #1”.
Now, ReBirth will receive MIDI Clock from Cubase, via OMS.

ReBirth set up to receive MIDI Clock from the OMS IAC port.

3. Close the dialog.

4. Activate Sync to MIDI Clock from the Options menu in ReBirth.

5. Activate playback in Cubase VST.
ReBirth will start playing ‘in sync’ with it and the Sync LED on the Transport 
will indicate the beats.

● Note that this makes the two programs play at the same time, that is, they both 
“run” when you “hit play”. It does not means they can both play audio at the 
same time. See page 86 for details about “sharing audio”.

“Live Sync”

See page 97 for more information on how to make the most out of ReBirth’s “Liv
Sync” feature.
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Cubase for Windows

● Before you create any serious projects that require sync, try out the features 
described below and check out “Synchronization Considerations” on page 
84.

ReBirth synchronizes to Cubase for Windows via a utility called ”Hubi’s Loopba
Device”. This utility is included on the ReBirth RB-338 CD-ROM, in the folder
“Hld” (Hubi’s Loopback Device).

Installing

1. Insert the ReBirth RB-338 CD-ROM into your computer.

2. Locate the folder “Hld” on the CD-ROM.

3. Find the file “How to Install HLD” in this folder, and double click on it.

4. Follow the instructions on screen.

Setting Up Cubase

1. In Cubase, pull down the Options menu, and make sure “Play in Back-
ground” is activated.
If it isn’t, and you want it to always be, you should consider modifying your 
DEF.ALL song, see the section about Customizing in the Cubase manual, for 
details.

2. Open the Synchronization dialog in Cubase.

3. In the Sync Out section, locate the MIDI Clock pop-up. Pull down the 
menu and select the desired output (”LB1” if you haven’t renamed the 
MIDI “ports” in Hubi’s Loopback Device).
This routes the MIDI Clock Signals out to Hubi’s Loopback Device, from 
where ReBirth RB-338 can receive them.

Cubase set up to transmit MIDI Clock to the “LB1” port.
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Setting Up ReBirth

1. In ReBirth, pull down the Edit menu and open the Preferences dialog.

2. In this dialog, pull down the Input menu in the MIDI Input section, and 
select the corresponding Input (possibly “LB1”).
Now, ReBirth will receive MIDI Clock signals from Cubase, via Hubi’s Loop-
back Device.

ReBirth set up to receive MIDI Clock from the “LB1” port.

3. Close the dialog.

4. Activate Sync to MIDI Clock from the Options menu in ReBirth.

5. Activate playback in Cubase.
ReBirth will start playing ‘in sync’ with it and the Sync LED on the Transport 
will indicate the beats.

● Note that this makes the two programs play at the same time, that is, they both 
“run” when you “hit play”. It does not means they can both play audio at the 
same time. See page 86 for details about “sharing audio”.

“Live Sync”

See page 97 for more information on how to make the most out of ReBirth’s “Liv
Sync” feature.
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Synchronization Considerations

Adjusting the Sync Delay

Sync Delay (Mac version)

Because of the latency problem described on page 155, you might need to adjust 
ReBirth RB-338’s playback in relation to Cubase, so that they are in perfect ti
The tempo will not differ between the two, but ReBirth might play ahead or beh
Cubase.

You might need to adjust this. However, this is something you only need to do o
The setting is stored with your other preferences, which means there’s no nee
adjust this setting again. Proceed as follows:

1. Set up Cubase so that it generates a solid click, on for example quarter or 
eighth notes, preferably with a special sound on the downbeat.
This click can either come from the internal metronome or from a MIDI 
source. If you use a MIDI source, make sure you pick one that has solid MIDI 
timing.

2. Set up ReBirth so that it plays a rhythm similar to the other application.
Use distinct sounds that are similar to the metronome in the other application, 
for example CB and CL.

3. Start the two applications in sync.

4. Make sure you hear both applications at approximately equal level.

5. Open the Preferences dialog in ReBirth.

6. Trim the “Adjust Sync” setting until the “clicks” from both sources sound 
at exactly the same time.

7. Close the Preferences dialog in ReBirth.

About the beginning of the Song

Due to the latency phenomenon, described on page 155, ReBirth needs some time
to correct it’s playback speed when it first receives the Start command. This ca
noted as a small glitch in the audio playback, when the program starts. If this
problem, you need to insert a couple of empty measures at the beginning of t
Song. Proceed as follows:

1. Make sure you are in Song mode, in ReBirth.

2. Set up the Loop so that it starts at Bar 1 and is two Bars long.

3. Move to Bar 1, the beginning of the Song.

4. Select Copy from the Edit menu.
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5. Select Paste from the Edit menu.
You now have two more measures at the beginning of the Song. Let’s make 
them silent:

6. Activate recording, but not playback.

7. Deactivate all three sections, in the Pattern selector.

8. Move the Song Position to Bar 2.

9. Deactivate Recording.

10.In Cubase, set up the Left Locator at the beginning of the Song and the 
Right Locator at bar 3 (3.1.0).

11.Make sure that all Tracks that you use in the Song are unmuted.

12.Pull down the Structure menu and select Global Insert.
You now have two empty bars at the beginning, both in Cubase and in Re-
Birth.

About tempo readouts

If the other program/device also has a tempo display, you might note slight di
ences in tempo readout between ReBirth and the other device/application. Th
normal, especially if the other is an external device, and does not mean the two ap-
plication do not sync properly. MIDI Clock does not contain numeric informati
about which tempo to play in. Rather, the tempo has to be calculated by the r
ing device, by measuring the pace the clock signals are coming in at. Just like
two watches, there will always be minor differences in their “speed”.

About Tempo Changes

Again, due to the latency phenomenon, ReBirth RB-338 needs a bit of time to
just to changes in tempo. If there are abrupt changes in the MIDI Clock, due t
drastic tempo changes on the master, you will note that ReBirth RB-338 will r
quire up to one measure to adjust itself to the change.

To minimize this problem, try to use gradual tempo changes rather than imme
ones.

Also note that drastic tempo changes might introduce slight “clicks” in the out
from the Delay unit in ReBirth.
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Audio Sharing
When you run ReBirth RB-338 together with Cubase, you might run into a situa
where you have two applications playing audio at the same time. To make this w
read the following section.

If you only use Cubase for MIDI (if you never use audio Tracks) this situation 
might not be a problem for you, but you still need to make sure ReBirth has ac
to the audio on the computer, see below.

Cubase VST for Macintosh

If you only use Cubase for MIDI

If you never use any audio Tracks in Cubase VST, you only need to make sur
VST does not “steal” the audio on your computer.

1. Launch Cubase VST.

2. Select System from the Audio menu.

3. Make sure the program uses the “Apple Sound Manager” ASIO driver.

4. Close the dialog.

If you run Cubase with the Sound Manager

If you use the internal audio on your computer, Cubase VST gives you the opti
accessing these via the “Apple DAV” and via the Sound Manager. While the "A
DAV" method is more efficient for VST, it is not available on all computers. Th
"Apple DAV" method is also a 'single user' system; once VST is using the audi
the computer ReBirth RB-338 can't access it too.

To run the two programs at the same time and have both playing audio, you must 
select the Apple Sound Manager driver in VST, as described above.

If you run Cubase with an audio card for which there is an ASIO driver

Cubase VST can also access a number of audio cards “directly” (as opposed
the Sound Manager) via ASIO drivers. Examples of such cards are the Digide
Audiomedia III and Korg 1212.

If you use such a card, you can still play audio from both applications at the s
time. ReBirth uses the Sound Manager (the audio appears on the standard M
tosh outputs) and the other application uses the sound card.

1. Make sure that no Sound Manager driver is installed for the card.
Such a driver might have been included with the card and is in that case lo-
cated in your System Folder. Please remove it and restart your computer.

2. Set up VST to access the card via an ASIO driver.

3. Launch ReBirth.
It will use the internal audio outputs on your Macintosh.
- 86 - 



t Cu-

f this 

 as the 
 
rds, 
Cubase for Windows

If you only use Cubase for MIDI

If you never use any audio Tracks in Cubase, you only need to make sure tha
base does not “steal” the audio on your computer.

• To ensure ReBirth has access to the audio on your computer, always 
launch ReBirth first.

If you have two audio cards and want to use audio in both programs

If you have two audio cards, Cubase can use one and ReBirth one:

1. In Cubase, open the Hardware Setup dialog and select the other audio 
card from the Record and Playback menus.

2. Launch ReBirth, open the Preferences dialog and select one of the audio 
cards from the Audio Card driver menu.

If you only have one audio card and want to use audio in both programs

Well, then you’re in a bit of a fix, because the current version of Cubase (as o
writing) will “grab” the audio card it is using, which means ReBirth will stop 
sounding.

There are exceptions to this rule, however. Some advanced audio cards, such
Terratec EWS-64, can “fool” the computer into thinking there is more than one
card installed. If you have such a card, follow the instructions for use of two ca
above.

You’re only other solution in this case is to use Export Audio, as described on page 
101 and page 119.
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Synchronization

● Synchronization on the Macintosh computer requires you to have OMS in-
stalled.

What is Synchronization and MIDI Clock?

Synchronization, in this context, is when you make ReBirth play at the same te
as another device; where both start, stop and can locate to certain positions, 
er. This is done by transmitting MIDI Clock signals between ReBirth and the o
device. MIDI Clock is a very fast “metronome” that can be transmitted in a MI
Cable. As part of the MIDI Clock concept there are also instructions for Start, S
and locating to sixteenth note positions.

You can set up synchronization between ReBirth and hardware devices (tape
corders, drum machines, stand alone sequencers, workstations etc) and othe
puter programs running on the same or another computer.

Master/Slave

In a synchronized system there is always one master and one or more slaves.
case, the master is the one that controls the tempo. In other words, it is only th
po setting on the master device that is of any relevance, since the slaves slav
follow the master's tempo.

• ReBirth always acts as a slave. That is it receives MIDI Clocks, it never 
transmits them.

● Before you create any serious projects that require sync, try out the features 
described below and check out “Synchronization Considerations” on page 
94.
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Slaving ReBirth RB-338 to an External Device 

This example assumes you have an external device, such as a drum machine
ware sequencer, another computer, tape recorder etc, that transmits MIDI Clo
that you want to synchronize ReBirth to.

1. Connect a MIDI Cable from the MIDI Out on the other device to a MIDI 
In on the computer running ReBirth.

2. Set up the other device so that it transmits MIDI Clock signals to the 
MIDI Out you just connected to the computer running ReBirth.

3. In ReBirth, pull down the Edit menu and open the Preferences dialog.

4. In this dialog, pull down the Input menu in the MIDI Input section and 
select the MIDI Input to which you connected the MIDI cable from the 
other device.
On the Macintosh, if you do not understand which Input this is, or if that MIDI 
input doesn’t appear in the list, consult your OMS documentation for infor-
mation on MIDI interfaces, MIDI ports and naming.

ReBirth Mac set up to sync to MIDI Clock coming in via the Printer port on an Opcode Studio 
4 interface.

Under Windows, if you can’t find the MIDI Input you want to use, there is ei-
ther something wrong with the installation of the interface, or some other pro-
gram is holding on to it. Consult the documentation for the MIDI interface, 
the other program and Windows, for more information.

ReBirth Windows set up to sync to MIDI Clock coming in via the MIDI interface on a Sound 
Blaster card.

5. Close the dialog.

6. Activate Sync to MIDI Clock from the Options menu in ReBirth.

7. Activate playback on the other device.
ReBirth will start playing ‘in sync’ with it and the Sync LED on the Transport 
will indicate the beats.
- 90 - 



ich 
Macintosh Platform – Slaving ReBirth RB-338 to Another Program on the 
Same Computer, using OMS

ReBirth supports the OMS IAC (Inter Application Communication) system, wh
allows you to run MIDI Clock signals from another program to ReBirth.

1. Install OMS, and make sure that IAC gets installed properly.
This might require you to use the Custom install option. To verify, check the 
OMs folder in your System Folder, after installation. It should contain a file 
called “OMS IAC Driver”.

2. Make sure you have an IAC symbol in your OMS Setup document.
If not, create a new Studio Setup, and when you’re asked whether you want to 
use IAC, activate that option.

3. Open the OMS MIDI Setup dialog in OMS Setup and make sure that “Run 
MIDI In Background” is enabled.

4. Quit OMS Setup.

5. Set up the other program, so that it transmits MIDI Clock to one of its 
dedicated “program ports” or to the OMS IAC port.
It doesn’t matter which you choose. If you feel unsure about which port to 
use, select IAC. If you want use a “program port” make sure you launch the 
other application before you launch ReBirth.

6. In ReBirth, pull down the Edit menu and open the Preferences dialog.

7. In this dialog, pull down the Input menu in the MIDI Input section and 
select the MIDI Port you selected for Output in the other application.

ReBirth Mac set up to sync to MIDI Clock coming in via an OMS IAC port.

8. Close the dialog.

9. Activate Sync to MIDI Clock from the Options menu in ReBirth.

10.Activate playback on the other device.
ReBirth will start playing ‘in sync’ with it and the Sync LED on the Transport 
will indicate the beats.
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Macintosh platform – Slaving ReBirth RB-338 to a non-OMS Program on 
the Same Computer

If the MIDI program you use does not support the professional standard for M
on Macintosh computers, OMS, you can still set up synchronization, but this r
quires two MIDI interfaces, each connected to one of the serial ports on your 
puter.

1. Set up OMS so that it uses only one of the MIDI interfaces installed.

2. Set up the other application so that it uses the other MIDI interface.

3. Connect a MIDI cable from an output on the “other application” inter-
face to an input on the OMS-controlled interface.

4. Set up the other application so that it transmits MIDI Clock signals to the 
output you connected the cable to.

5. In ReBirth, pull down the Edit menu and open the Preferences dialog.

6. In this dialog, pull down the Input menu in the MIDI Input section and 
select the MIDI Port you connected the cable to.
If you do not understand which Input this is, or if that MIDI input doesn’t ap-
pear in the list, consult your OMS documentation for information on MIDI in-
terfaces, MIDI ports and naming.

7. Close the dialog.

8. Activate Sync to MIDI Clock from the Options menu in ReBirth.

9. Activate playback on the other device.
ReBirth will start playing ‘in sync’ with it and the Sync LED on the Transport 
will indicate the beats.
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Windows platform – Slaving ReBirth RB-338 to an Another Program on 
the Same Computer

ReBirth synchronizes to other programs on the same computer via a utility ca
”Hubi’s Loopback Device”. This utility is included on the ReBirth RB-338 CD-
ROM, in the folder “Hld” (Hubi’s Loopback Device).

Installing

1. Insert the ReBirth RB-338 CD-ROM into your computer.

2. Locate the folder “Hld” on the CD-ROM.

3. Find the file “How to Install HLD” in this folder, and double click on it.

4. Follow the instructions on screen.

Setting up the applications

With the ”Hubi’s Loopback Device” utility installed, you will find a number of ne
MIDI Inputs and Outputs in your MIDI applications. These are “invisible MIDI c
bles” that run between the MIDI programs on your computer.

1. In the other application, set things up so that it transmits MIDI Clock sig-
nals to the desired output (”LB1” if you haven’t renamed the MIDI 
“ports” in Hubi’s Loopback Device).

2. In ReBirth, pull down the Edit menu and open the Preferences dialog.

3. In this dialog, pull down the Input menu in the MIDI Input section, and 
select the corresponding Input (possibly “LB1”).
Now, ReBirth will receive MIDI Clock signals from the other application, via 
Hubi’s Loopback Device.

ReBirth set up to sync to MIDI Clock coming in via “LB1”.

4. Close the dialog.

5. Activate Sync to MIDI Clock from the Options menu in ReBirth.

6. Activate playback on the other device.
ReBirth will start playing ‘in sync’ with it and the Sync LED on the Transport 
will indicate the beats.

● Note that this makes the two programs play at the same time, that is, they both 
“run” when you “hit play”. It does not means they can both play audio at the 
same time. See page 100 for details about “sharing audio”.
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Synchronization Considerations

Adjusting the Sync Delay

Sync Delay (Mac version)

Because of the latency problem described on page 155, you might need to adjust 
ReBirth RB-338’s playback in relation to the sync master, so that they are in pe
time. The tempo will not differ between the two, but ReBirth might play ahead
behind the other application. You might need to adjust this. However, this is so
thing you only need to do once. The setting is stored with your other preference
you don’t need to adjust it again.

Proceed as follows:

1. Set up the other application so that it generates a solid click, on for ex-
ample quarter or eighth notes, preferably with a special sound on the 
downbeat.
This click can either come from an internal metronome or from a MIDI 
source. If you use a MIDI source, make sure you pick one that has solid MIDI 
timing.

2. Set up ReBirth so that it plays a similar rhythm as the other application.
You might for example use the CB and CL sounds.

3. Start the two applications in sync.

4. Make sure you hear both applications at approximately equal level.

5. Open the Preferences dialog in ReBirth.

6. Trim the “Adjust Sync” setting until the “clicks” from the both sources 
sound at exactly the same time.

7. Close the Preferences dialog in ReBirth.
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About the beginning of the Song

Due to the latency phenomenon, described on page 155, ReBirth needs some time
to correct it’s playback speed when it first receives the Start command. This ca
noted as a small glitch in the audio playback, when the program starts. If this
problem, you need to insert a couple of empty measures at the beginning of t
Song. Proceed as follows:

1. Make sure you are in Song mode, in ReBirth.

2. Set up the Loop so that it starts at Bar 1 and is two Bars long.

3. Move to Bar 1, the beginning of the Song.

4. Select Copy from the Edit menu.

5. Select Paste from the Edit menu.
You now have two more measures at the beginning of the Song. Let’s make 
them silent:

6. Activate recording, but not playback.

7. Deactivate all three sections, in the Pattern selector.

8. Move the Song Position to Bar 2.

9. Deactivate Recording.

10.Set up the other device/application, so that it also plays two empty bars 
at the beginning.

About MIDI Song Position Pointers

MIDI Clock actually consists of five type of messages: The actual clock (the m
ronome that establishes the tempo), Start, Stop and Continue commands and
Position Pointers. This last type of message contains information about positi
so that a program for example “knows” where in a Song to start playback from

Normally, this ensures that you can locate to any position and activate playba
from there. In older devices, Song Position Pointers might not be implemented.
means that you will be able to synchronize properly only if you start both devi
from the absolute beginning of the song.

About Tempo readouts

If the other program/device also has a tempo display, you might note slight di
ences in tempo readout between ReBirth and the other device/application. Th
normal, especially if the other is an external device, and does not mean the two do 
not sync properly. MIDI Clock does not contain numeric information about wh
tempo to play in. Rather, the tempo has to be calculated by the receiving devic
measuring the pace the clock signals are coming in at. Just like with two watc
there will always be minor differences in their “speed”.
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About Tempo Changes

Again, due to the latency phenomenon, ReBirth RB-338 needs a bit of time to
just to changes in tempo. If there are abrupt changes in the MIDI Clock, due t
drastic tempo changes on the master, you will note that ReBirth RB-338 will r
quire up to one measure to adjust itself to the change. How long this actually 
also depends on the precision of the incoming MIDI Clock. The more precise 
the faster ReBirth can adjust to it.

If this adjustment is a problem, try to use gradual tempo changes rather than 
diate ones.

Also note that drastic tempo changes might introduce “clicks” in the output fro
the Delay unit in ReBirth.
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Using “Live Sync”

Background Information

What is commonly referred to as “MIDI Clock” is actually four different types o
MIDI messages:

• Start and Stop
These are the messages sent out when you Start and Stop your sync master.

• Song Position pointers
These are messages used for sending out positions, so that a slave can deter-
mine where in a Song to start from. If you for example fast forward your mas-
ter to bar 80 and hit play, ReBirth will also start from bar 80.

• The actual clock messages.
Once playback is going, the only messages that are sent are the actual clock 
messages, that allow the slave to play in the same tempo as the master.

ReBirth RB-338 responds correctly to all these messages. Understanding the 
ence between them will help you make the most out of the live sync feature in
program, see later in this chapter.

The Sync and MIDI LEDs

The MIDI LED

The MIDI LED indicates the program is receiving MIDI data.

The MIDI LED on the front panel lights up on all types of MIDI messages, incl
ing MIDI Clock. This means that if this is lit, MIDI clock messages are actually
coming in on the MIDI port specified in the Preferences dialog. This can be us
for determining whether the MIDI ports are set up correctly and whether the m
is actually set to transmit MIDI Clock messages.

● Most devices (but not all) transmit MIDI Clock messages even when in Stop 
mode. This means that if the Master is set to transmit MIDI Clock, the MIDI 
LED on the ReBirth transport panel might be lit constantly, regardless of 
whether the master is playing or not. This is completely normal!
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The Sync LED

The Sync LED indicates the program is in sync with another program or device.

The Sync LED shows the status of the incoming sync and provides a visual in
tion of the bar position. It blinks red on the downbeat and green on all other b

This LED is only operational when the master has been started. This is an ind
tion that ReBirth is in sync mode. Again, this can be used for troubleshooting:
you get an indication on the Sync LED but still have no sync, there can only be
reasons:

• Sync to MIDI Clock is not activated on the Options menu, (or in the Pref-
erences dialog), or...

• You have hit Stop on the ReBirth transport panel. Hit Play again.

Stopping, Starting, and Opening Songs in Sync mode

When ReBirth RB-338 has received a Start message it is by definition “in sync
til it receives a Stop message from the master.

You can hit Stop on the ReBirth transport panel, but the program will keep coun
clocks “in the background”. This allows you to:

• Hit Stop, wind the Song Position to any position in the Song and hit Play 
again.
Playback will start again on the next downbeat.

• Switch to another Song window, move the Song position to any position 
and hit Play.
Playback will stop immediately in the Song that is now playing, and will 
resume in the current Song document, at the next downbeat.

• Open a Song document, move the Song position to any position and hit 
Play.
Opening another document does not affect playback. Not until you hit Play 
does the newly opened document actually start playing (at the next down-
beat).

● Windows 95 users might experience short audio playback glitches while Song 
documents are being loaded from disk. The risk of this happening depends on 
a number of factors; among others the speed of your computer and hard disk 
and the size of the audio buffers as set in the ReBirth Preferences dialog (the 
larger the safer). If this is a problem, open all Songs you intend to play back, 
before you start your “syncing session”.
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Repositioning the Master

As described above, you can Start and Stop ReBirth RB-338 as much as you
during playback. This will naturally introduce a difference between the Song p
tions in the master and in ReBirth. For example, when the master indicates ba
ReBirth might be playing bar 12 or 257, all depending on your use of the ReB
transport panel.

However, if you change the Song position on the master, for example by windin
rewinding, it will most likely send out a Song Position Pointer message to ReB
which will adjust itself so that the two program play the same measure.

When the Master Device is in Stop mode

If you Stop the Master, you can still activate Playback in ReBirth RB-338. It w
then play in the tempo set on the Transport bar, not necessarily the same tem
the master is set to.
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Running multiple Audio Applications on one Computer
You might want to run ReBirth RB-338 together with another audio application
the same time. Since ReBirth synchronizes, you might for example want to ru
“in tandem” with an audio sequencer. Exactly how to do this depends on your 
puter configuration and the platform you are on.

Windows

Under Windows, two applications normally do not share an audio card. If you
launch two applications, one of them will “grab” the audio card, which means 
other will stop sounding.

How can I make ReBirth RB-338 and another application play audio at the 
same time?

There are three ways:

• Use two audio cards. You can then assign one to ReBirth (see the installa-
tion instructions) and one to the other audio application.
However, this assumes the other application does not “grab” all the audio 
cards in your computer. Please refer to that program’s documentation for de-
tails.

• A few audio cards can mix the audio from several applications. An exam-
ple of such an audio card is Terratec EWS-64. This card “fools” Windows 
into thinking there is more than one card installed into the system. If you 
have such a card, you can set up both applications to use it.

• If all applications are compatible with DirectX 3 or later and support the 
“secondary buffer feature” in DirectX (see page 156), they can all 
“share” one audio card.
ReBirth of course fulfils both these DirectX requirements.

A note about background playback

If you access the audio card via DirectX version 2, ReBirth will not be able to p
in the background. That is, as soon as you switch to another application, ReB
will stop sounding.
- 100 - 



osh, 
rom 
 stan-
 ap-

he 
 is 
(Cu-
hen 

, you 
ative.

ess 
f such 
er. If 
 the 
ard 

38 to 
te the 
Macintosh

ReBirth RB-338 plays audio via the standard audio procedures on the Macint
called the Sound Manager. The Sound Manager has the ability to mix audio f
several applications. This means that if you run ReBirth together with another
dard audio application, the audio from both will automatically be mixed and will
pear at the stereo outputs on the computer.

If the other application uses special audio routines, that “grab” the sound on t
computer, ReBirth will not be able to play. An example of such an application
Steinberg Cubase VST, when set to the “Apple DAV” audio output alternative 
base does this for good reason, to maximize the resources of the computer w
playing back audio from hard disk).

If you need to have ReBirth and Cubase VST playing audio at the same time
must switch Cubase VST to its Sound Manager compatible audio output altern

Some audio applications that use audio cards installed into the computer, acc
these cards directly (as opposed to using the Sound Manager). An example o
a setup would be Cubase VST with an audio card accessed via an ASIO driv
you run such an application, you can still play audio from both applications at
same time. ReBirth uses the Sound Manager (the audio appears on the stand
Macintosh outputs) and the other application uses the sound card.

Using “Export Loop as AIFF/Wave” to Overcome the “One Audio Card 
Only” Problem.

If you only have one audio card, or for other reasons can not get ReBirth RB-3
play at the same time as another audio program, there are still ways to integra
audio from the two applications:

1. Create a Song in ReBirth.
You can do this either without running any other application at the same time, 
or while being synchronized with another application, only utilizing its MIDI 
capabilities, so that ReBirth has access to the audio on your computer.

2. Export the ReBirth Song as an audio file (see page 119).

3. Quit ReBirth.

4. Import the audio file into the other application, as a stereo audio track.

5. Continue working on the Song in the other program. If you need to make 
changes in the ReBirth material, either use the editing capabilities of the 
other program, or go back into ReBirth, make the necessary change, ex-
port the file and re-import into the other program, replacing the previous 
ReBirth track.
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About differences in tempo between applications

Computer applications handle tempo in different ways. Some drive their temp
from the clocking of the digital audio (ReBirth RB-338 uses this method) while
other programs use other types of timing methods. This means that when you
two applications to 120 BPM (without any synchronization between them) and
start them at the same time, they might tick away at slightly different speeds, 
if they run on the same computer.

For this reason, an audio file generated in ReBirth at a certain tempo, might n
play back in perfect time with the material in the other program, even if they pla
the same tempo.

To get around this, use the other application’s tempo adjustment methods to m
the material already present in the other program to the audio file.
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Introduction
This feature allows you to control practically all parameters on the ReBirth pa
via MIDI. This can be used either as a way of playing ReBirth RB-338 “live” o
when you want to control it via a MIDI sequencer, rather than using ReBirth’s
built-in automation.

Standard Mapping vs Quick Mapping

There are two major modes for Remote MIDI control, which you can select be
tween from ReBirth’s Preferences dialog:

Standard Mapping

This is the preferred mode for those with advanced MIDI setups, for example 
programmable fader panels etc.

Quick Mapping

This is the preferred mode if you want to control the most common parame-
ters, for example from your keyboard synth’s wheels and pedals.

More on these modes later in this text.

About MIDI Channels and Inputs

The MIDI Input and Channel settings in the Preferences dialog are used to de
mine which external device should be used for Remote MIDI control.

● ReBirth RB-338 only receives MIDI messages, it does not transmit any MIDI.
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Setting up Remote MIDI Control from External MIDI 
Hardware

If you have some MIDI device connected to your computer that you want to us
controlling ReBirth RB-338, proceed as follows:

1. Set things up so that the device you want to use for transmitting MIDI 
messages is connected to the desired MIDI input.
Please note that if you want to synchronize ReBirth at the same time as using 
Remote MIDI Control, you must set things up so that the synchronization 
messages come in on the same MIDI input as the controller messages.

2. If you are running ReBirth on a Macintosh computer, create a device in 
OMS setup that corresponds to your external MIDI device and save your 
setup.
See the OMS documentation for details.

3. Launch ReBirth.
If you run ReBirth on a Macintosh it is important that you launch ReBirth after 
making changes to OMS, or the changes you have made will not be available 
in ReBirth.

4. In ReBirth, open the Preferences dialog.

The MIDI section of the Preferences dialog (Macintosh version shown here).

5. Activate Remote MIDI Control.

6. Select the MIDI Input port and MIDI channel that your controller is 
transmitting on.

7. Choose Standard or Quick Mapping, and if required, click the Edit button 
to set up the Quick mapping.
The details on these modes and the Quick Remote MIDI Mapping dialog are 
described on page 107 and onwards.
- 105 - 



 use 
Setting up Remote MIDI Control from another Program
If you have another program running on the same computer, that you want to
for controlling ReBirth RB-338, proceed as follows:

1. Set up the other program so that the Tracks you want to use for control-
ling ReBirth transmit to a MIDI port and MIDI channel that ReBirth can 
receive on.
If you are running ReBirth RB-338 on the PC this will probably be one of the 
ports added to your system by HLD (Hubi’s Loopback Device – see page 93). 
If you are using a Macintosh, this will be an OMS IAC port (page 91).

2. Launch ReBirth.

3. In ReBirth, open the Preferences dialog.

4. Activate Remote MIDI Control.

5. Select the MIDI Input port and MIDI channel that the other program is 
transmitting on.

6. Choose Standard or Quick Mapping, and if required, click the Edit button 
to set up the Quick mapping.
The details on these modes and the Quick Remote MIDI Mapping dialog are 
described below.
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Standard Mapping vs Quick Mapping

Standard Mapping

In the Standard Mapping mode practically all controls can be accessed. Howe
this mode more or less assumes you have access to a special hardware or so
control panel, where the controls can be programmed to send arbitrary MIDI 
sages. Since there is such a multitude of controls available in Standard Mapp
mode, accessing them from for example a normal synth keyboard or master k
board, with only a few sliders, becomes ergonomically difficult.

The MIDI implementation used in Standard mode can be found on page 170 and 
onwards.

Quick Mapping

Quick Mapping, on the other hand, is perfect for those with limited MIDI equip
ment. Even if you only have access to a modulation wheel on your synth, it ca
put to good use when recording knob movements in Song mode or when play
live.

How to set up the relation between your controller devices and ReBirth’s funct
is described in the next paragraph.
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Setting up Quick Mapping
1. Setup Remote MIDI Control as described earlier in this chapter.

2. Open the Preferences dialog and make sure Quick Mapping is selected.

3. Click the Quick Mapping Edit button.

The Quick Mapping dialog.

Manual Setup

1. Select a function you want to use, from the set of pop-up menus.

2. Click in the field to the right of the pop-up and type in the number of the 
controller message you want to use.

Using Learn

1. Select a function that you want to use, from the set of pop-up menus.

2. Move the controller you want to use for this function.
The field at the bottom of the dialog shows the number for this controller. If it 
doesn’t, this is an indication your MIDI connection is not set up correctly. See 
Checking Your Setup, below.

3. Click the Learn button associated with the function you want to use.
This controller number is entered in the corresponding value field.

Checking your Setup

There are a few techniques you can use to check that your setup is done corr

• Use the MIDI LED on the Transport panel.
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This responds to on all MIDI messages except System Exclusive. If it lights up, th
means some type of MIDI data on some MIDI Channel is coming in on the MIDI 
port selected in the Preferences dialog. If this doesn’t light up, check your othe
vice, your MIDI interface and your MIDI port setup (Macintosh users should ch
OMS Setup).

The MIDI LED indicates incoming MIDI data.

• Changes that you make in the Quick Mapping dialog are effective imme-
diately, even while the dialog is up on screen.
This means you can have playback going while you set up the Quick Mapping 
dialog. Make sure you are in Pattern mode and check your mapping as you go 
along.

• The controls move on the screen when they receive MIDI messages, even 
when the dialog is up on screen.
This can be used as visual feedback. If a control moves, it is mapped correctly.
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Using Remote MIDI Control
Once your Remote MIDI Control connection is up and working it can be used
numerous ways:

• To run the program “live”, in Pattern or Song mode.
See the tips on live usage on page 77.

• To record your Song automation in a more natural way than when using 
the mouse.
This is convenient even if you only have a couple of MIDI controllers to use at 
a time. After each recording pass you can open the Quick Mapping Edit dia-
log and map those controllers to other functions in the program.

• As a way of completely controlling ReBirth from an external hardware 
device.
This assumes you have a very advanced hardware controller with many but-
tons, knobs and faders.

• To record parts of, or all of your Song automation in another program.
You would then remain in Pattern mode but send Pattern changes and control 
messages from the other program. Essentially, you then move all of the Song 
mode functionality over to the other program.
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Important Notes about MIDI Control
• There is only one MIDI input port to the whole program.

If you want to synchronize and control knobs, etc – all at the same time – you 
have to make sure both the MIDI clock signals and the controller data is sup-
plied on the MIDI Input selected in the Preferences dialog. Use the MIDI LED 
on the transport bar to check whether any MIDI data is coming in via the se-
lected port.

• Only one MIDI Channel is used at a time.
All Controller data must be transmitted on the same MIDI Channel, the one 
selected in the Preferences dialog.

• Only MIDI Control Change messages are received in Quick Mapping 
mode.
Do not confuse Control Change messages with other, similar types of MIDI 
messages, such as pitch bend, aftertouch, key pressure etc.

• ReBirth only reads OMS ports on startup.
Macintosh users should be aware that your OMS configuration is only 
checked when you launch ReBirth. Any changes made to your OMS Setup 
will not take effect until you Quit ReBirth RB-338 and launch it again.

• Minimize Latency!
As described in the main ReBirth manual, there is a short delay between the 
moment when you move a control with the mouse and when this takes effect 
on the sound output. This is called latency. Exactly the same delay affects Re-
mote MIDI control. Make sure the sound buffer settings in the Preferences di-
alog are adjusted to the lowest possible values, as described in the main 
ReBirth manual.
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New Songs – Changing the Default Settings
To create a new “blank” Song, select New from the File menu.

New songs can either use default settings for Patterns and controls, or you ca
tomize the settings so that New Songs appear just as you want them.

Customizing

1. Set up a Song so that it is exactly as you want New Songs to be.

2. Open the Preferences dialog.

3. Click the “Use Current Song” button at the bottom of the dialog.

4. Close the dialog.

The Default Song plays a number of “factory Patterns” intended to get you sta
with the program. To “silence” a Pattern, click the Clear button in the relevant s
section.

When you get better acquainted with the program you might want to customize
described above. One quick way of doing this is to load one of two Song files
cated in the ReBirth folder, and then use the “Use Current Song” feature desc
above:

• “ReBirth 1.0 Default Song”. This makes the program behave as in version 
1.0. New Songs play silent rhythm Patterns and repeating 16th note synth 
Patterns.

• “Silent Default Song”. This contains all silent Patterns.
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Saving Songs
When you save your Song, using the Save and Save As commands, you save
Patterns, all settings in Pattern mode and the entire Song, all in one file.

The file dialog used for saving is the standard Windows/Macintosh one. For de
about saving, hard disks, floppy and other media, see the manual that came 
your computer and storage devices.

The Song Information Feature

If you like you can enter information about your Song. This is useful for examp
you intend to distribute your files via Internet and want to make people aware
who the creator is.

Filling in the Dialog

1. Select Song Information from the File menu.

2. Fill in the three fields:

• Text in Window Title will always appear in the Song window title.

• “More Information” and “Creator’s web page” will appear in the Informa-
tion dialog and in the “splash screen” that appears when you load the 
Song (if Show Information...” is activated, see below”).

3. If you like, activate “Show Information on Song Open”.
This ensures everybody will see the information when they load the Song.

Linking to the Song creator’s web page

If the Song creator has entered a URL to a web page, you can launch your pre
web browser and display the page. Proceed as follows:

1. Open the Song Information dialog.

2. Click on the Browse button.
On the PC, your default browser launches directly. On the Macintosh you 
have to select a browser in a dialog. In either case, the browser takes you to 
the specified web page.
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Opening Songs
• Using the Open Dialog

You can of course open saved Song files using a regular Open dialog.

• Using Drag and Drop
ReBirth supports standard Drag and Drop features on each platform.

• Using The Recent Documents Menu Items
There is a “recent documents” section on the File menu. This lists the four 
most recently opened Song files. Selecting one re-opens that file.

Macintosh Memory Note

If you can’t open as many Songs as you’d like, this is probably because you ha
assigned enough memory to the program. Proceed as follows:

1. Quit ReBirth.

2. Locate the ReBirth RB-338 icon in the Finder and select it.

3. Select Get Info from the File menu.

4. In the dialog that appears, assign more memory to the program.
For exact details on this dialog, see your Macintosh manuals. Exactly how 
much memory you can assign to the program depends on the amount of 
memory installed in your Macintosh.

● Avoid assigning the program so much memory that none is left for the system 
once ReBirth RB-338 and other programs are running. The Sound Manager 
(the routines in the Macintosh that handle audio) require that some system 
memory is left unused after all applications have been launched.

Switching between Windows

You can have as many Song documents open as you like, or as memory per
However, only one of them can play back at a time.

You can switch between windows by clicking on them, or by using the Window
menu. This does not affect which window is playing back. Not until you click t
Play button in the active Song window does that Song start playing.
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Switching to Other Programs

As described on page 100, ReBirth RB-338 can play “in the background”, if som
basic criteria are met. This means that the current Song will keep playing eve
you switch to another program.

Stay on Top (Windows only)

The Windows version of ReBirth RB-338 has an item on the Windows menu, ca
“Stay on Top”. When this is activated, the ReBirth window will always stay on 
of other program’s windows. This is intended mainly for when you sync ReBirt
another music program. Since the other program is always the Master, you wi
its transport panel for playing and stopping. Activating this function ensures y
can do this without having your ReBirth windows hidden behind other window

Copying and Moving Patterns between Songs
Since there is no Pattern file format, only the Song format, it might not be obv
how to Copy and move Patterns between Songs. This is done using Cut, Cop
Paste, as described on page 45.
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Moving ReBirth Song files between Macintosh and PC 
Computers

Moving ReBirth RB-338 Song files between Mac and PC platforms is easy. As 
any file, getting it from the Mac to the PC or vice versa, requires some kind of 
able media (DOS-formatted floppies for example) or a network. However, once
file is on the desired computer disk, the following applies for loading it into Re
Birth RB-338:

Loading Mac files on the PC

On the PC, the file extension must be “.rbs”. This allows you to double click the
to open it, and it will have the right file icon.

Loading PC files on the Mac

On the Mac the file must meet at least one of two criteria:

• File Type “TSSQ” and Creator “ReBi”.
This ensures the file has the right icon. However, changing the File Type and 
Creator requires special software, see below. Ask your computer dealer if in 
doubt.

• File extensions “.rbs”.
This will allow you to open the file, but it will probably not have the right icon 
in the Finder.

Opening the file

• Regardless of whether the file has the right icon or not, you can always 
open it using the Open dialog in ReBirth or by using Drag and Drop.

• However, if the file doesn’t have the right icon you can not open the file 
by double clicking it in the Finder.

When you re-save a file it automatically gets the correct File Type and Creato

Setting the File Type and Creator

There are numerous ways of setting the File Type and Creator of files brought
a PC to the Mac. Let us just mention two:

• Using PC Exchange.
This utility is included with every Macintosh computer. It allows you to set up 
“mapping”, so that when a DOS formatted floppy disk (and some other types 
of media) is inserted, files with a certain extension are automatically given the 
correct File Type and Creator.
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• Using ZipIt.
This shareware program can be used for unpacking files archived in the com-
mon PC format, “Zip”. ZipIt can be set up so that when a file with a certain 
extension is extracted from an archive, it automatically gets the desired File 
Type and Creator.
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Exporting Songs and Patterns as Audio (AIFF/Wave) files
You can save your entire Song, or parts of it, as an audio file. This file can be
AIFF (Audio Interchange File Format – the standard audio file format on the M
intosh) or Wave (“WAV” – the standard audio file format on the PC). Proceed
follows:

1. Make sure you are in Song mode.

2. Set up the Loop so that it encompasses the part of the Song you want to 
convert.
This can be a Loop of any Length, from a one bar Pattern to the whole Song. If 
you want to export the whole Song, remember to include some extra bars at 
the end, so that any repeats from the Delay section get included.

3. Select “Export Loop as Audio File” (PC) or “Export Loop as AIFF/Wave 
file” (Mac) from the File menu.

4. Specify a name and location for your file.
On the PC platform, select a file format (AIFF or Wave), from the pop-up at the 
bottom of the dialog.

5. Click Save.

● Audio files are relatively big! For example, a three minute Song will occupy 
over 30 MBytes of hard disk space.
- 119 - 



14

Reference 15
- 120 - 



nd 
per-
Transport Panel

Song Mode/Pattern Mode

This switches ReBirth RB-338 between its two major modes: Pattern mode a
Song mode. The two modes have major differences. Below we will list the pro
ties for each one, in list form:

Pattern Mode

• Allows you to program the synths and rhythm sections.

• You can switch Patterns at any time.

• Allows you to manually set all knobs as you like them at any time.

• The Fast Forward and Rewind controls are not used.

• Always loops the selected Patterns.

• The Record button isn’t used.

Song Mode

• Allows you to build a complete Song by recording Pattern changes and 
knob movements.

• Requires recording to be activated to be able to use controls and select 
Patterns.

• Introduces the loop feature which allows you to repeat any section of the 
Song infinitely.

Tempo control 
and display

Switches between 
Song and Pattern 
mode

Displays the Song 
Position and 
allows you to 
move in steps of 
one bar

Define where the 
Song Loop Starts 
and Ends

Play Stop Moves the Song 
Position ten bars 
forward

Moves the Song 
Position ten bars back

Record - for recording 
Pattern changes and 
controls in Song mode

Song Loop On/OffShows MIDI 
In activity

Indicates that 
ReBirth is in 
Sync with 
another device.
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MIDI Indicator

This “LED” lights up to indicate incoming MIDI messages. It reacts on all MID
messages except System Exclusive. Use this as a visual indication that your 
setup is done correctly.

Sync Indicator

This “LED” indicates incoming MIDI sync. It blinks red on the downbeat and 
green on all other beats. Use this as an indication that the master device (the
transmitting the MIDI Clock messages) is actually started and the MIDI setup
done correctly.

This indicator is also used in conjunction with the “Live Sync” feature, which a
lows you to start and stop ReBirth and even switch between Song documents
out losing sync. See page 97 for details. 

Tempo

Here you can set the tempo for your Song in “bpm” (beats per minute). The ra
is 20 to 500 bpm (80 to 160 is a “normal” range of tempos).

When ReBirth is synchronized to another device, this setting is of no importan
since ReBirth will play in the tempo of the other device.

Bar Display

This shows the current position in bars (measures). Only relevant in Song mo
you click one of the arrow buttons the Song Position is moved one measure b
forward. If you keep the mouse button down, it scrolls continuously.

Play

This activates playback. If you are in Song mode, this should be thought of as 
tinue play”, that is it will start playback from the current position.

Stop

• When you click this during playback, the program stops.

• If the program is already stopped, the Song Position moves to the Loop 
Start.
There's an exception to this: If the Song Position is already at an earlier posi-
tion than the Left Locator, it moves to the beginning of the Song.

• If you click one more time, the Song Position moves to the beginning of 
the Song.
In other words, clicking three times always moves you to the beginning of the 
Song.
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Rewind

Every click on this button moves the Song position ten bars back. If you keep
mouse button pressed, it rewinds continuously.

Fast Forward

Every click on this button moves the Song position ten bars forward. If you kee
mouse button pressed, it fast forwards continuously.

Record

This button is used for recording Pattern changes and knob movements in So
mode. It has no function in Pattern mode.

Loop On/Off

When this is activated, the section specified by the Start and Length settings 
Looped.

Loop Start and Length

The Loop start is the bar where you want looping to start.

The Length setting is the number of bars you want looped.
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Pattern Section

Bank and Pattern Selectors

These are used for selecting between the 32 Patterns available for each sect
each Song.

• To select another Pattern, in the same Bank, simply click one of the Pat-
tern buttons.

• To switch to another Pattern in another Bank, first select the Bank, then 
the Pattern.

No Pattern gets selected until you click one of the Pattern buttons 1 to 8.

You can also switch Patterns from the computer keyboard, see page 18 and page 
194.

Step Display and Setting

This is used for setting the length of the Pattern, in steps of 16th notes. This c
done at any time and affects playback immediately.

You can even have different Pattern lengths for different sections. Each one l
independently. Different Patterns can have different lengths.

Selects between the eight 
Patterns in a Bank

Selects between 
the four Banks of 
eight Patterns

Used for deactivating 
the section. Essentially 
the same as an empty 
Pattern

Allows you to set the 
Length of the Pattern, in 
16th note steps
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Rhythm Section

Sound Selector

This knob is used for selecting between the main sounds.

For more info about selecting sounds, see page 24.

For information about the “shared instruments”, see page 28.

The white knobs are 
used for adjusting the 
various sound 
parameters

Click on the light 
instrument legends to select 
an instrument

The red knobs set 
the levels of the 
individual sounds

The colored step 
buttons are used 
for programming 
the selected 
instrument into the 
Pattern

The large knob is used 
for selecting instruments
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Sound Switches – About the “Shared Instruments”

As stated in the table above, some instrument ”slots” can only play one of two
sounds. In these cases, there’s a small switch that allows you to select which 
will be played by this instrument “slot”. You can flick the switch any time. Wha
ever is programmed for this “instrument slot” will be played by the sound sele
at that time.

Tone

This knob adjusts the “color” of the sound. Exactly in which way depends on 
sound, but the higher the setting, the “brighter” the sound.

Decay

This adjusts the length of the sound. The higher the setting, the longer the so

Legend Name Comment

AC Accent This is not a sound, but rather a way to control dynamics. 
The steps where Accent is activated will be louder. Ex-
actly how much louder is determined by the Accent 
Level control. This control has equal effect on all sounds.

BD Bass Drum Has Tone and Decay controls.

SD Snare Drum Has Tune and Snappy controls.

LT Low Tom Has a tune control. “Shared” with Low Conga.

MT Middle Tom Has a tune control. “Shared” with Middle Conga.

HT High Tom Has a tune control. “Shared” with High Conga.

LC Low Conga Has a tune control. “Shared” with Low Tom.

MC Middle Conga Has a tune control. “Shared” with Middle Tom.

HC High Conga Has a tune control. “Shared” with High Tom.

RS Rim Shot  “Shared” with Claves.

CL Claves  “Shared” with Rim Shot.

CP (Hand) Claps  “Shared” with Maracas.

MA Maracas  “Shared” with Claps.

CB Cowbell No comment...

CY Cymbal Has a Tone and Decay Control.

OH Open Hi-hat Has a Decay Control. Is cut off by the Closed Hi-hat.

CH Closed Hi-hat Cuts off the Open Hi-hat. If you have both open and 
closed Hi-hat on one step, you will hear an open hi-hat 
with an extremely short decay.
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Tune

This adjusts the pitch of the sound. On the Snare Drum it only affects the “tone”
of the sound, not the “noise” part.

Snappy

This is only available for the Snare Drum. It is actually a level control for the 
“snare” (noise) part of the sound. The higher the setting, the more of the “snare
will hear.
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Synth Section

Pitch Mode

• When this is activated, the sequencer will automatically advance to the 
next step as soon as you select a pitch, using the Pitch buttons.

• When this is deactivated, the sequencer never advances automatically to 
the next step.

• If you deactivate and then immediately activate Pitch mode, you return 
to the first step in the Pattern.

Clear

This Clears the Pattern completely. This means all steps are set as follows:

Pitch buttons

These are used for specifying a Pitch for the selected step.

Function Setting

Pitch Low C

Note/Pause Pause (no sound!)

Down Off

Up Off

Accent Off

Slide Off

These controls are used 
for adjusting the sound

Click these buttons to set 
the pitch for the step

Selects between two 
waveforms, Square 
and Sawtooth

Pitch Mode 
On/Off

Various buttons 
for programming 
a step (see 
below)

This shows you which 
step in the Pattern you 
are programming

Clears the 
Pattern
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Down

This transposes the pitch of the selected step down, one octave.

Up

This transposes the pitch of the selected step up, one octave.

You can activate both Up and Down at the same time, if you wish. However, th
the same as activating none of them.

Accent (button)

This activates Accent for the selected step. For more information on what effec
cent has, see the Accent knob, page 131.

Slide

When this is activated, the selected step will be tied to the next (legato – no “r
gering”) and the pitch will slide continuously to that of the next step. For a mo
thorough explanation of how Slide works, see page 39.

Note/Pause button and indicators

This is used for specifying whether the selected step will sound or not.

Back

This takes you to the previous step in the Pattern. When you are at the first ste
takes you to the last step in the Pattern.

Step

This takes you to the next step in the Pattern. When you are at the last step, thi
you to the first step in the Pattern.

Step display

This indicates which step you are currently at, when entering notes. This cha
when you press Next or Back or when you specify pitches in Pitch mode. It doe
move on playback.
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Waveform

This allows you to select between two waveforms for the synth oscillator:

Tune

This allows you to set the tuning of the synthesizer. The range is two octaves
steps of one semitone.

Cutoff

This sets the basic cutoff frequency for the filter. The higher this setting, the brig
the sound. This is the basic filter setting. The final filter curve is determined by o
settings, like Env. Mod, Decay and Accent.

For a more thorough description of the filter section, see page 42.

Reso

This also determines the character of the sound. The technical explanation is 
routes the output of the filter back into the input, in a “feedback” loop. This kn
determines the amount of feedback. The higher the sound, the more of the ty
hollow character you will get.

Env. Mod

This determines the amount of effect the filter envelope has on the filter settin

• In its lowest position, the envelope has little effect on the sound.

• At higher values, the envelope makes the filter open further, that is the 
sound will be brighter.

Decay

The higher this setting, the longer it will take for the notes to decay.

Symbol: Name: Description:

Sawtooth This is a full and rich waveform where all harmonics are in-
cluded.

Square This waveform only contains odd harmonics, which gives 
the sound a more “hollow” quality.
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Accent (knob)

This determines the amount of change to those steps that have the Accent sw
tivated.

• Steps with Accent will be perceived as shorter, louder and with a slightly 
different tonal character than other steps, when this setting is increased.

• When this knob is all the way down, steps with Accent will only be 
shorter.

For more information on the relationship between Accent and other parameter
page 43.
- 131 - 



 level 
ndi-

lance 

 

inal 
y sec-
Mixers

On/Off switch

This turns the output of the relevant section on/off.

Meter

This shows the output level from the section. Use this as a diagnostic tool if the
from a section is very low or if you don’t hear it at all. If this meter shows any i
cation at all, the section is playing. 

Volume fader

This determines the level of the output from the relevant section. Use this to ba
the relative levels between the synths and the rhythm section.

● Please note that as you increase levels you might run into distortion. To com-
pensate for this, use the Master fader. See page 21 for more details about lev-
els and “clipping”.

Pan

This determines the section’s position in the stereo image.

The range of the parameter is fully left (L), through centre (“twelve o'clock”) to
fully right (R).

Delay

This determines the amount of delay (echo) to be added to this section. The f
amount of delay is determined by a number of other settings in the actual Dela
tion. See page 55 for details on how to use the delay.

Output meter

Volume fader

Mute/unmute. Not part 
of the Song automation!

Delay amount for 
this section

Distortion on/off

Pan

PCF on/off
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Dist

This is a switch which routes the output of this section through the Distortion (D
unit. For more information on how to use the Distortion effect, see page 53.

PCF

This is a switch that routes the output of this section through the PCF (Pattern
trolled Filter) unit.
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PCF

The PCF effect is basically a filter with an envelope, just like there are filters w
envelopes in the synth sections. You route the output of one of the sections th
the PCF and thereby shape the tonal character of the sound.

The main difference between the PCF and the synth filters is that this filter is 
tern controlled”. There are a number of preset patterns that allow the filter to “
perimpose” pumping effects, slow sweeps and rhythmic phrasing onto the so

On/Off switch

This turns the PCF effect on/off. When turned off, sound will pass through the
fect without any filtering. This button is very similar to a Bypass button on a reg
effect unit.

Meter

This shows the input level to the PCF. Use this as a diagnostic tool if you are u
whether any signal appears at the input of the PCF section. If this meter show
indication at all, some signal is coming in.

Pattern

There are a large number of preset patterns that provide various rhythmic effe
They do this by controlling the following envelope parameters:

• Retriggering.
This is the most basic type of control. For example, in Pattern 0 the envelope 
is retriggered (restarted) at each whole note, in pattern 1 on each half note etc.

• Dynamic and Attack control.
In many of the Patterns, the envelope is triggered with different dynamics on 
different “beats”. Some “beats” also have a slightly different attack.

The Patterns are preset, they can not be changed. Their length varies, most ar
32 steps (one or two bars), but some have been created in odd time signature

See page 179 for a list of all Patterns.

PCF on/off

Filter type 
select

Pattern 
selection

Frequency 
(cutoff)

Envelope 
Amount

Envelope 
Decay

Q 
(Resonance)
- 134 - 



lider 
as a 
is all 

tes 
wise 

r any 

 the 
Mode (BP/LP)

This switches the filter between its two major modes, lowpass and bandpass.

• The lowpass filter (LP) is similar to the one used in the synth sections in 
ReBirth. It lets all harmonics below a certain frequency (the cutoff fre-
quency) pass through.

• The bandpass filter (BP) only lets frequencies within a certain band (a 
range of frequencies) pass through.

Freq (Frequency)

This is the main frequency range the filter should operate in.

The Freq parameter is related to the Amount (Amt) parameter: If the Amount s
is set to zero, there will be no pattern effect at all. The filter can then be used 
fixed “tone control” by adjusting the Freq and Q parameters. If the Freq slider 
the way up, the Amt slider has no effect since the filter is already fully open.

Q

This is the same as the “Reso” control in the synth sections. Technically it rou
the sound at the output of the filter back to the input, in a feedback loop. Sound
it gives the sound a more hollow, pronounced character.

● Be careful when combining large Q values in the PCF with large Reso values 
in a synth, since this might lead to overloading the output of the PCF, causing 
distortion.

Amt (Amount)

This control determines the amount of effect the envelope has on the filter. Fo
Pattern effect at all, this must be set to some value above zero.

Decay

This adjusts the length of the envelope decay. This has a significant effect on
“feel” of the Pattern.

• At low values there will be a clear pumping effect.

• When the Decay is raised, the pattern effect will be “smeared”. This can 
be used to good effect with Patterns 12 to 17 for smooth “LFO” effects.

• At very high values, the envelope will not be given a chance to decay very 
much until it is retriggered, giving a “stepping” effect (similar to the old 
synth effect “sample and hold”). This is most noticeable on patterns with 
dynamics (12 and above).
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Dist (Distortion)

Distortion is an effect which makes the sound “dirtier”. One section at a time ca
routed to the Distortion effect, using the Dist switches in the mixers.

For more detailed information on how to use the Distortion effect, please see page 
53.

On/Off switch

This turns the Distortion effect on/off. When the Distortion is turned off, any so
will pass through the effect without being distorted. This button is very similar 
Bypass button on a regular effect unit.

Meter

This shows the input level to the dist. Use this as a diagnostic tool if you are un
whether any signal appears at the input of the Dist section. If this meter show
indication at all, some signal is coming in. 

Amount

This determines the amount of distortion. The higher the setting, the dirtier th
sound.

Distortion 
on/off

Distortion 
Amount
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Delay

Delay is an effect which adds repeats or echo to the sound.

This is a “send effect”, which means that any and all sections can be routed t
effect, by variable amounts.

For more detailed information on how to use the Delay effect, please see page 55.

On/Off switch

This turns the Delay effect on/off. When turned off, any sound will pass through
effect without any delay added. This button is very similar to a Bypass button 
regular effect unit.

Meter

This shows the input level to the Delay. Use this as a diagnostic tool if you ar
sure whether any signal appears at the input of the Delay section. If this meter s
any indication at all, some signal is coming in. 

Step and Straight/Triplet switch

These two controls determine the length of the Delay.

• If the Straight/Triplet switch is set to straight 16th notes, Steps is used for 
setting the length in 16th note steps. 

• If the Straight/Triplet switch is set to triplets, Steps is used for setting the 
length in steps of 8th note triplets.

F.Back

To get more than one echo, you can route the output of the Delay unit back to
input. This is often referred to as Feedback. The F.Back knob on the ReBirth d
does exactly this.

● Please be careful when raising this knob to high values. At full value, the echo 
repeats infinitely. While this can be used to good effect, it is something to be 
aware of.

Delay on/off

Feedback (number
of repeats)

Delay Length (sixteenths 
or eighth note triplets)

The panning of the 
output from the delay

Sixteenth note/eighth 
note triplet switch
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Pan

This determines the position of the delay output, in the stereo image.

The range of the parameter is fully left (L), through centre (“twelve o'clock”) to
fully right (R).
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Master

The Master level and faders.

Meters

These show the Output level from the entire program. Adjust this with the fade
that the meters show as high levels as possible during loud passages, withou
hitting the red top segment. For more information see page 21.

Fader

This is used for adjusting the overall output level from the program. Use this to
er with the meters to retain maximum level without clipping.
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Menus and Dialogs

Apple menu (Mac only)

About ReBirth RB-338...

This menu item opens up a dialog that informs you about the version of the pro
and the people behind it.

File menu

New

This creates a new ReBirth panel. Use this when you want to start on a Song
scratch. The settings and Patterns in this window are determined by the Prefe
setting “Pattern and knob settings for new songs”, see page 113.

Open...

This menu item is used for opening saved Song documents. It brings up a reg
file dialog where you can locate a Song file on disk and open it.

Close

This menu item closes the currently active window. If it is a document window, 
you have made any changes since you saved it last (or not saved the docum
all) you will be asked whether you want to save those changes before closing
window.

Save

This menu item allows you to save any changes you have made to the curren
tive document (the one you’re working on, or playing). If you have not yet sav
the document, selecting this is the same as selecting Save As, see below.

Save As...

This is used for saving a document the first time, or to save an existing docum
under a new name or at a new location. A regular file dialog allows you to spe
a name and location for the file.

Windows users might want to note that ReBirth RB-338 songs have the docu
extension “.rbs”.
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Song Information

This allows you to enter some information about your Song. This is useful for
ample if you intend to distribute your files via Internet and want to make peop
aware of who the creator is.

Export Loop As AIFF/Wave File (Mac)/Export Loop As Audio File (PC)

This menu item allows you to export the current Song (or a section of it) as an a
file. This file can later be played back from any program that can read audio fil
the specified format.

Only the area inside the Loop is saved. This allows you to specify any section o
Song to be saved, down to a single measure.

Page Setup...

This standard Macintosh/Windows item opens up a dialog box that allows you
make settings for the printer you plan to use. See the documentation that cam
your Macintosh/Windows computer and printer, for more details.

Recent Documents

In this section of the menu you will find up to four of your most recently opene
Song documents. Selecting one of these opens it.

Quit

This will quit the program. If any documents have unsaved changes you will b
asked if you want to save those changes before quitting.

Item: Description:

Text in Window Title This text always appears in the Song window title.

More Information This text will appear in the Information dialog and in the 
“splash screen” that appears when you load the Song (if 
Show Information...” is activated, see below”)

Creator’s Web Page Same as above.

Show information on 
Song open

If this is activated, “More Information” and “Creator’s Web 
Page” will appear in a window when the Song opens.

Browser When you click this, you will be taken to the web page 
specified in the dialog.
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Edit menu (Pattern mode)

The content of the Edit menu varies with the “mode” of the program. Below follo
the items available when you are in Pattern mode:

About the “focus”

All the Pattern operations below act on the Pattern that currently has the “foc
This means the Pattern with the focus bar. See page 19 for details.

Undo

This is not used in ReBirth RB-338.

Cut Pattern

This function is mainly used together with Paste to move Patterns between Pattern
locations.

It will copy the contents of the Pattern into the Clipboard, from where it can late
Pasted in to another Pattern location. In addition the Pattern will be Cleared, s
low.

Copy Pattern

This function is used together with Paste to copy Patterns between Pattern location
It will copy the contents of the Pattern into the Clipboard, from where it can late
Pasted in to another Pattern location.

Paste Pattern

This will paste the Pattern currently on the Clipboard, into the selected Patter
cation. The Pasted Pattern will replace whatever was previously at that locati

Clear Pattern

This empties the selected Pattern.

For synth Patterns this means that all steps are set as follows:

Function Setting

Pitch Low C

Note/Pause Pause (no sound!)

Down Off

Up Off

Accent Off

Slide Off
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Shift Pattern/Drum Left/Right

This shifts the contents of the Pattern one sixteenth note in either direction. F
ample, if you shift right, what was on the first step will be on the second, what 
on the second will be on the third, and so on. In the same example, whatever w
the last step will be on the first.

• When the focus is on a synth section, only Shift Pattern Left/Right is 
available. This shifts the entire content of the Pattern one step in the se-
lected direction.

• When the focus is on a rhythm section, you have the option of shifting 
the whole Pattern or just the selected drum sound.

Random Pattern/Pitches/Accents etc./Drum

This creates random synth and drum Patterns. This can be used as an inspir
tool (create a Pattern and modify the parts you don’t like) or for completely co
puter generated music.

The exact options available depend on the focus (synth section or rhythm sec
See page 47.

Alter Pattern/Pitches/Accents etc./Drum

This randomly shuffles the synth and rhythm Patterns, using the already pro-
grammed material as a basis for a new Pattern. See page 48.

Transpose...

The Transpose dialog (Macintosh version).

This only applies to synth Patterns. It allows you to transpose the Pattern to an
key. See page 48.
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Preferences...

This dialog contains a number of overall settings and options for the program

The Windows Preferences dialog.

The Mac Preferences dialog.
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Control: Description:

Audio Card Driver (PC only) Use this to select one of the card drivers in 
your system. See page 8 for more details 
about the available options.

Playback Performance slider (PC 
only)

This is used for setting the size of the buffers 
associated with audio playback. The smaller 
this number, the faster ReBirth will react to 
changes on the front panel. On the other 
hand, smaller settings require a faster audio 
card driver and computer. Again see the on-
line help and page 156 for details.

Play Ahead (PC only) This indicates the size of the audio playback 
buffer, as adjusted with the slider.

Underruns (PC only) This shows the number of instances that the 
playback buffers have been “too small” with 
the current setting. If you get underruns, you 
need to raise the size of the buffer.

Multitasking friendly/Crackle safe 
(Macintosh only)

This allows you to select between two 
modes for creating audio on your computer. 
See page 9 for details.

Buffer size (Macintosh only) This should be set to the lowest possible 
value that provides glitch free audio play-
back.

MIDI Input This is used for selecting a MIDI Input for 
synchronization and remote control, see 
page 79, page 89 and page 103.

MIDI Clock Sync Enable This is a double up of the setting “Sync to 
MIDI Clock”, on the Options menu, See 
page 79 and page 89.

Adjust Sync Setting This setting is used for trimming the syn-
chronization, so that ReBirth RB-338 “locks 
in” with the master. See page 84 and page 
94.

Remote MIDI Control This is used for turning Remote MIDI Con-
trol on/off. When this is activated, ReBirth 
can be controlled via MIDI as set up in this 
dialog (and possibly also in the Quick Map-
ping dialog).

MIDI Channel This is used for specifying a MIDI channel 
for remote control messages.

Use ReBirth’s Standard Mapping When this is selected, practically all con-
trols on the front panel can be accessed via 
MIDI. However, the “mapping” between 
MIDI messages and front panel control is 
fixed, you can not modify it. See page 107 
for details.
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Use Quick Mapping When this is activated, only a selection of 
front panel controls can be accessed via 
MIDI Controller messages. However, by 
clicking the Edit button you can set up ex-
actly which, and how.

Edit Clicking this button opens the Quick Setup 
dialog.

Patterns and knob settings for new 
Songs

The two options here are used for setting 
whether new Songs should have default Pat-
terns and knob settings or if they should “in-
herit” Patterns and settings from the current 
Song. This is used for “customizing” the 
contents of New Songs. See page 113.

Control: Description:
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Quick Setup

This dialog is used for “mapping” incoming MIDI Controller messages to contr
on the ReBirth front panel, in Quick Setup mode.

Manual setup

1. Select a function you want to use, from the set of pop-up menus.

2. Click in the field to the right of the pop-up and type in the number of the 
controller message you want to use.

Using Learn

1. Select a function that you want to use, from the set of pop-up menus.

2. Move the controller you want to use for this function.
The field at the bottom of the dialog shows the number for this controller. If it 
doesn't, this is an indication that your MIDI connection is not set up correctly.

3. Click the Learn button associated with the function you want to use.
This controller number will then appear in the corresponding value field.
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Control: Description:

ReBirth knob pop-ups Use this to select a knob on the ReBirth front 
panel that you want to control via MIDI.

MIDI Control ID fields Use this to type in the MIDI Controller num-
ber you want to use for controlling the knob 
selected in the pop-up.

Learn buttons When you click a Learn button, the last re-
ceived MIDI Controller number (as dis-
played in the “Received MIDI Control ID to 
Learn” field) is automatically entered in the 
box just to the left. Use this as quick way of 
mapping controls on your synth, fader panel 
or similar, to knobs on the ReBirth front 
panel.

Received MIDI Control ID to Learn This field shows the number of the last re-
ceived MIDI Controller message. Use this as 
verification of incoming MIDI and in con-
junction with the Learn buttons.
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Edit menu (Song mode)

The contents of the Edit menu varies with the “mode” of the program. Below f
lows the items available when you are in Song mode:

Undo

This is not used in ReBirth RB-338.

Cut Loop

This menu item removes measures from the Song and puts them in the Clipb
More specifically, Cut removes all measures inside the Loop. This can be use
two purposes:

• When you want to make the Song shorter.

• Together with Paste, to move measures from one section of the Song to 
another.

Copy Loop

This menu item copies all the measures inside the Loop and puts them in the
board from where they can be pasted in.

Paste at Song Position

Adds the Cut/Copied measures to the Song, beginning at the Song Position. 
measures are inserted into the Song, so that is lengthened.

If you for example have Cut four bars and use “Paste at Song Position”, at Son
sition 13, you will get four new measures between measure 13 and 16. These
tain the pasted material. Whatever was at bar 13 before the operation is now at bar
17.

Paste Replace at Song Position

Similar to Paste at Song Position, but when this option is selected, the Pasted
rial overwrites the material currently in those measures.

Again, if you Cut four bars, and use “Paste Replace at Song Position”, at Son
sition 13, the contents of measures 13, 14, 15 and 16 will be replaced by the 
ures on the Clipboard.

Initialize Loop from Pattern Mode

This “initializes” the measures inside the Loop. This can be a convenient way
use the settings currently in Pattern mode, as initial settings for some measur
the Song you are building.

● Please note that this command clears all the Pattern changes and knob record-
ings currently inside the Loop!
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When you use “Initialize Loop from Pattern Mode”, all measures inside the Lo
are filled with the settings currently made in Pattern mode. That is, the three P
terns selected in Pattern mode will be used, as well as all knob and other con
settings.

Initialize Song from Pattern mode

This is used for initializing the Song, to start over from scratch. It also allows 
to use the settings currently in Pattern mode as your initial settings for the Son
are about to build.

● Please note that this command clears all the Pattern changes and knob record-
ings currently in the Song!

When you use “Initialize Song from Pattern Mode”, all measures in the Song 
filled with the settings currently made in Pattern mode. That is, the three Patt
selected in Pattern mode will be used, as well as all knob and other control se

Copy touched controls to Loop/Song

This menu item allows you to insert “static” settings for any control, for a num
of bars. For example, you might want to turn on the Delay and make sure tha
turned on for the whole Song, or you might want to adjust some level control, 
specific number of bars.

A full explanation of this function can be found on page 72. 

Preferences...

See page 144.
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Options menu

Sync to MIDI Clock

When this is activated, ReBirth RB-338 will synchronize its playback to incom
MIDI Clock.

When synchronized to MIDI Clock, the tempo is determined by the other devic
application – the tempo on the ReBirth transport bar is of no relevance.

You do not need to activate Play in ReBirth. As soon as it senses that the oth
vice/application starts, it will start automatically.

To determine which MIDI source to synchronize to, open the Preferences dia
and change the Sync Input setting.

For more information about external sync, see page 79 and page 89.

Program Synth from Keyboard

When this is activated, the computer keyboard is used for programming the sy
sizer that currently has the focus (see page 19 for more info about focus). To learn
how to program the synthesizer from the keyboard, see page 37.

Select Patterns from Keyboard

When this is activated, the computer keyboard is used for selecting Patterns.
more information see page 18 and page 194.

Windows menu

Stay on Top (Windows only)

When this is activated, the ReBirth window will always stay on top of other pro
gram’s windows.

Window List

This lists all the open Song documents. Selecting one makes it the active win
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Contacts/Help menu

Help... (Windows only)

This menu item open up the Topic window for the Windows on-line help syste

About the Internet menu alternatives

Regardless of which of the four Internet options you select, you will be conne
to the Internet using your preferred browser (on the PC this happens directly, o
Macintosh you have to select a browser in a dialog). The browser will then take
to the page specified in the dialog.

If you prefer, you can of course note down the web address in the dialog and 
nect manually instead.

Order ReBirth RB-338...

This directs you to the ReBirth Ordering pages.

Get Free Songs...

This takes you to our archives of song files that you can download and use, e
with the demo version. You can also contribute with your own creations!

Get Tech Support...

Got a problem? This will take you to the ReBirth technical support pages.

Contact Steinberg...

If you are interested in more info from ReBirth’s music retailer distributor, use 
option.

About ReBirth RB-338... (Windows only)

This menu item opens up a dialog that informs you about the version of the pro
and the people behind it.
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About Audio on Computers 16
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General Information

Audio Quality

The general audio quality in a computer based synthesizer system depends o
things:

• The quality of the software calculating the audio.
In our case, this is the ReBirth DSP (Digital Signal Processing) code. And what 
can we say? We have invested all our expertise and an enormous amount of 
time to make ReBirth RB-338 sound as good as possible. All calculations are 
made at the highest possible resolution throughout the signal chain. The 
44.1kHz sampling frequency is maintained at all times. A number of digital 
audio techniques are implemented that reduce the risk of “aliasing”, back-
ground noise, unwanted distortion and “zipper noise”. OK, we’ll say it 
straight out: ReBirth sounds awesome.

• The quality of the hardware playing back the sound.
In a PC this is the sound card. In the Mac it is the built in audio circuitry or 
any audio card you have installed. Don’t be fooled by the “16 bit, 44.1kHz, 
CD quality” tags. How good some audio hardware actually sounds depends 
on a number of things, its frequency range and frequency response curve, the 
signal to noise ratio, the distortion under various circumstances, etc. Further-
more, some designs are more prone to disturbance from the other electronics 
in the computer, than other. Such disturbance might add hum or high pitched 
noise to the signal.

As you probably understand by now, this is a big subject and there’s no way 
we can help you find the right solution in this manual. There are a number of 
text books and magazines covering this subject and any music dealer special-
izing in computers will happily help you out. The only advice we can give 
you is that if you are serious about sound, choose your audio hardware care-
fully!

● PC users, please read the paragraphs about DirectX on page 156, it might 
have an impact on your choice of audio hardware.
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About Latency

On any personal computer system, there is a delay between the moment you
the hardware to play a sound and when it actually does it. This delay is referr
as the “latency” of the design. This imposes a problem for any system where 
want real time user input to affect the sound.

What is acceptable?

As a comparison, consider a hardware synthesizer. Here, you normally wouldn
cept a latency (between key down and sound out) of more than 3 to 7 ms (mi
onds – thousands of a second), if the instrument is to be used “professionally

On a regular PC or Mac, the latency is anywhere from 25 to 300ms! This is ju
effect of the fact that a computer was built for many purposes, not just playing 
audio. For multimedia and games, this is perfectly acceptable, but for playing a
sical instrument it is not!

For this reason, you can not play the sounds in ReBirth RB-338 via MIDI. It wo
feel just awful.

ReBirth’s built in sequencer is not affected by latency!

However, when the sound is played back via a built in sequencer, such as in Re
RB-338, the timing between notes is perfect! Once playback of a ReBirth Patte
Song is up and running, latency isn’t a consideration at all. The computer clock
audio between the steps and does this with perfect quartz accuracy! The timi
immaculate!

Still, latency rears it ugly head in another part of the program:

• When you move controls on the front panel, the time it actually takes be-
fore these movements affect the sound depends on the latency.

• The timing accuracy of the meters on the front panel is determined by la-
tency.

For these two reasons, ReBirth has a buffer size setting in the Preferences d
This allows you to minimize the latency as much as possible. How much you 
be able to reduce the buffer sizes depends on your sound driver and your com
The faster it is, the smaller the buffers required.

Reducing latency

Having said this, there are general methods for reducing latency. The problem
that most of them are based on non-standard solutions that require special har
to be installed in your system. For a software developer they also impose prob
since special routines have to be written for each hardware solution.

On the Macintosh, it is the Sound Manager routines (part of the Mac OS) and
audio hardware in the computer that are responsible for the latency. 

On the PC, it is the Windows routines and the audio card that introduce laten
However, you do have some control over this via the choice of using MME or
DirectX drivers for your audio card, see below.
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PC Specific Information

About DirectX, MME and the Sound Buffer setting

There are two ways for Windows to access an audio card:

Via an MME (MultiMedia Extensions) driver

This system has been around since Windows 3.0, and it is this type of driver 
that is normally installed in the Control Panel and via Plug’n’Play. Most regu-
lar sound playback (like when Windows goes “bing” on startup) happens via 
MME.

• Practically all cards come with an MME driver. If your card appears in the 
System part of the Control Panel, you have an MME driver installed.

• Using a card via an MME driver gives you relatively long latency (see page 
155), especially under Windows 95.

• Only one program at a time can use a card accessed via MME.

• If you use MME, ReBirth RB-338 can play in the background.

• The latency is around 160 milliseconds when using MME under Windows 
95. 

Via a DirectX driver

DirectX is a later system developed by Microsoft to provide developers with 
more efficient routines to access audio. As of this writing, DirectX version 2 is 
included with Windows 95 and Windows NT. However, version 3 was the lat-
est and can be obtained from Microsoft. However, this does not mean you 
should always use DirectX on your system, read on.

• As of this writing, not all cards come with DirectX drivers. Drivers for 
some cards are included with DirectX itself.

• Using a card via a DirectX driver gives you a pretty short latency, between 
40 and 90 milliseconds under Windows 95 (see page 155).

• If you use DirectX 3 or later, all programs that access the card via DirectX 
and make use of the DirectX “secondary buffer” feature can use it at the 
same time and ReBirth RB-338 can play in the background.
These are the only two differences between DirectX 2 and 3 that concern Re-
Birth.
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Questions and Answers about DirectX

● This text is by no means a complete guide to DirectX! For more information, 
please point your web browser to: http://www.microsoft.com/DirectX/de-
fault.asp (the “DirectX Pavilion” at Microsoft).

Should I access my card via DirectX or MME?

ReBirth RB-338 can use DirectX or MME, the program will work fine with eith
system. However, if, and only if, you have a card for which there is a real Direct
driver, and this driver is installed correctly, you should use DirectX. This will allow 
you to reduce the latency (see page 155) which makes the program more responsiv
It will not make it sound better or give it any other additional features, but twis
knobs and moving controls will “feel better”.

How do I know if I have DirectX installed at all on my computer?

1. Launch ReBirth.

2. Pull down the Edit menu and select Preferences.

3. Pull down the Audio Card Driver menu in the dialog that appears And se-
lect the last driver on the list.
Check the text just below the pop-up. If it says “Driver Type: Direct X”, then 
you have DirectX installed.

How do I know if I have a real driver (as opposed to an “emulated driver”) 
installed for my card?

Select the various alternatives on the Audio Card Driver menu described above
at a time. The text that appears below tells you if the driver is “emulated”.

● If you have a DirectX driver not indicated as emulated, use it! On the other 
hand, if you only have emulated DirectX drivers, don’t use DirectX. Instead 
use one of the MME alternatives on the menu!

How do I know which version of DirectX I have installed?

You can’t, at least not really. However, you can tell if you have version 3 or lat

1. Start ReBirth so that it’s playing.

2. Switch over to another program, for example the Desktop.
If ReBirth keeps playing, you have DirectX 3 or later installed. If it stops you h
an earlier version.
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If I don’t have DirectX installed, should I install it?

There are two situations where we recommend you to install DirectX, if you d
have it already:

• If the card vendor can supply you with a DirectX driver.

• If your card is one of the few for which a driver is included with Mi-
crosoft’s DirectX package.
The list of included drivers changes constantly. Again, please visit the “Di-
rectX Pavilion” at the Microsoft web pages.

If I have DirectX version 2, should I install a later version?

The major difference between version 2 and later is that the later versions allow
eral applications to share one audio card, whereas version 2 does not.

If you’re the type that always want to keep your computer system up to date w
the latest version of any software, install a later version. If you’re the type that ra
stays with what you have, because you know and understand it, don’t.

Where do I get hold of DirectX?

Version 5 of DirectX is included on the ReBirth CD. For later versions, please 
the “DirectX Pavilion” at the Microsoft web pages, http://www.microsoft.com/D
rectX/default.asp.

Where do I get hold of a “certified” DirectX driver for my audio card?

There are two ways:

• A driver might be included with DirectX.

• Contact the card vendor or the dealer where you purchased the audio card 
and ask for a DirectX driver.
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Cyrix vs. Intel

As of this writing, the two major processor manufacturers are Intel and Cyrix. B
have their advantages and disadvantages, but actually, for ReBirth RB-338, an
processor is the best choice. Why?

This has to do with floating point calculations (counting with decimal numbers rat
er than with non-decimal numbers, integers.). Using floating point arithmetics en-
sures high audio quality. You can get high audio quality on an integer system
but floating point is effective and accurate when it is available.

Intel Pentium processors are much faster at floating point mathematics than Cyrix
586 and 686 chips. This means that much more of your computer’s processing
er will be used up when running ReBirth RB-338 on a Cyrix processor than o
Intel. This has the following effects:

• On a Cyrix processor you need to use larger buffer sizes (the buffer size 
is set in the Preferences dialog), to prevent the sound from “breaking 
up”.
Larger buffers makes the program less responsive to control changes, see page 
155.

• The updating of the graphics will be slower.
This can be noted when moving windows, pulling down menus etc.

• Other programs running at the same time, will not perform as fast as they 
otherwise do.

● Provided the buffering is OK, the speed of the processor has no effect on the 
sound quality. ReBirth RB-338 will sound just as good on an Intel processor as 
on a Cyrix or other brand!
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Macintosh Specific Information

What the Sound Manager does/is

The Sound Manager is a set of software routines in the Mac OS. These routine
care of everything related to sound.

The Sound Manager is built into the system. If you have the latest version of M
OS, you probably don’t need to install any special Sound Manager files. How
if you run an older OS version, you can install the Sound Manager included w
ReBirth, or any even more recent version you can get hold of (for example fro
Apple’s Internet pages: www.apple.com).

One specific character of the Sound Manager is its ability to mix audio from se
applications. This means that even when you run ReBirth, you can run other S
Manager compatible applications at the same time, and they will all sound.

Mac Audio cards

Even though all Macintosh computers have built in sound, there are Mac aud
cards which add capabilities to your system. Such capabilities can be addition
and outputs, digital connections, better sound quality, etc.

• If you have an audio card for which there is a well written Sound Manager 
driver (a piece of software that allows the Sound Manager to play via the 
card) you can use the card with ReBirth RB-338.

• If you use the card with some special software (such as a hard disk record-
ing system) that does not use the Sound Manager, you can still use that 
software and run ReBirth at the same time. ReBirth will use the built in 
sound connectors on your Macintosh and the other software will use the 
card.

Installing a Macintosh audio card for use with ReBirth

If you have an audio card for which there is a Sound Manager driver, you can 
with ReBirth RB-338. Proceed as follows.

1. Quit ReBirth if it’s running.

2. Install the card as described by the manufacturer.

3. Install the Sound Manager driver for the card, as described by the manu-
facturer.

4. Open the Monitors and Sound control panel.

5. Click on the Sound button.

6. Select the card from the list of audio outputs.
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7. Set up the levels and sound quality options as desired.

8. Switch to the warnings display and click on the sounds to check that they 
now play back via the audio card.

9. Close the dialog.

10.Launch ReBirth.
It will now play back via the audio card rather then via the computer’s built in 
audio outputs.
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Introduction
The intent of this chapter is to help you get as effective technical support as p
ble. Please read through the following before you contact technical support.

Where can I get Support?
This depends on where you bought the program:

• If you bought ReBirth RB-338 directly from Propellerhead Software, sup-
port is available via the Internet. See below for details.

• If you bought ReBirth from Steinberg Soft- & Hardware there are two ways 
to get support: via the Internet (see below) or by contacting your local dis-
tributor. If in doubt, examine your package for details on how to contact 
the distributor, or contact the dealer where you bought the program.

What you need to do before Contacting Tech Support
First of all, do you need help with some functionality in the program or do you 
pect something doesn’t work as intended? Read through the following points:

If the Program isn’t Behaving as Expected

Is the problem really with ReBirth RB-338?

Technical support personnel can unfortunately not help you with general prob
with your computer and peripherals. Furthermore, the operation manual and te
cal support facilities assume you have a basic understanding of how your com
works. If not, please go back and study the documentation that came with the
puter and related equipment.

“It worked before...”

Often, when a program stops working it is because you have installed someth
new or changed your configuration in some way. If possible, revert to the old s
and check if things work then.

When you have done so, install the new components one at a time and check
Birth in between each one. This will help you pinpoint exactly what it is that cau
the problem.

Do other programs behave normally?

Sometimes when you have problems with general things like audio playback, M
or file handling, it can help using other programs to perform similar operations
example, if none of your programs can play back audio, the problem might be
the audio card or its installation, rather than with the programs.
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Is everything installed properly? Did you really follow the installation 
instructions?

Installing hardware and software can be a daunting task. The instructions that 
with the devices and program are there for a reason. Even if you consider you
a seasoned expert, and even if the manufacturer boasts “Plug’n’Play” suppor
please read the instructions and ReadMe files, there might be something ther
missed!

Is there a system conflict?

Sometimes, problems that appear to be related to a certain program or device
actually caused by something entirely different. Try the following:

• Disable any system extensions and additions not required for running Re-
Birth RB-338.

• Remove any background (“memory resident”) programs that you have in-
stalled.

• Quit all other programs.

• Try with a simple computer configuration.

• Un-install any special hardware that might interfere with your system.

• Now, run ReBirth RB-338 again and see if the problem persists.

If there is Something you don’t understand

Did you really read the manual thoroughly?

We have to say this: a lot of time and effort was put into providing as accurate
complete documentation for ReBirth RB-338 as possible. Chances are that th
formation you are looking for is somewhere in this manual:

• Use the Table Of Contents for finding overall procedures.

• Use the Index to find descriptions related to certain terminology.

• Use the Find feature to search for keywords.

• Read the ReadMe files included with the program. These often contain 
last minute notes and information about special situations.

Reduce the number of pitfalls

When you try to come to grips with a certain procedure or function, try it on so
thing simple. Create some simple material that you can use as “workbench”. 
ble all unrelated functions and features, hold your breath, and try again. Often
when minimizing unrelated options, it is easier to see what is going on within 
program.
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What you need to have at hand

So, you tried all of the above, and you still have problems. This is what you ne
have at hand before you contact technical support:

Serial number and registration information

You must be prepared to state the program serial number of the program and
registration information. This is found somewhere on the package or on a sep
registration card.

Version number

This is very important. The version of the program can be found in the About 

System details

We will need to know many things about your system, like:

• Computer brand and specifications (RAM, hard disk, installed cards etc).

• Graphic and audio card details (driver versions etc.).

• Windows/Mac OS versions.

• Details about other programs you have installed.

A description of the problem

The importance of this can not be underestimated. A description like “it somet
crashes” doesn’t do much good. We need to know:

• The exact series of events that cause a problem.

• Reports about exactly where in the series of events the problem occurs.

• Detailed information about any error messages or alert boxes that appear.

How to Contact Tech Support

If you bought the program directly from Propellerhead Software

• Pull down the Contacts/Help menu and select “Get Technical Support”, 
or...

• Fire up your Internet browser and point it to www.propellerheads.se/
techsupport/.

If you bought the program from Steinberg Soft- & Hardware

• Contact your local distributor in the way they instruct you, or...

• Point your Internet browser to www.steinberg.net.
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This chapter explains some of the technical terms used in ReBirth and its docu
tation:

Accent In this context, a way to control the dynamics of a sound. 
A note played with accent is louder or more emphasized 
than other notes.

AIFF (.AIF) Abbreviation for Audio Interchange File Format. The stan-
dard audio file format on Macintosh computers.

Audio Card A card in your computer that provides it with audio in-
puts and/or outputs. When you hear the Windows 95 star-
tup sound on your PC, you’re hearing audio from the 
audio card. On a Macintosh, audio connectors are built 
in, which means adding an audio card is an option.

Audio File A file that contains digitized audio. Any audio recording 
you make on your computer is stored in an audio file.

Bank A set of Patterns. In each Section in ReBirth there are four 
Banks labelled A to D. Each Bank contains eight Patterns.

Bank Selectors The buttons used for selecting Banks.

Buffer A memory area used for storing data temporarily. For ex-
ample, when ReBirth RB-338 plays audio, it stores the au-
dio in a buffer where the audio card can read it before 
converting it to an audio signal.

Cubase Steinberg Soft- & Hardware’s state of the art audio and 
MIDI sequencer.

Cutoff A control on a Filter. In the case of ReBirth, it controls the 
“brightness” of the sound. 

Decay A control that determines the length of a sound.

Delay In a musical context, this is an effect that creates echoes 
and “repeats”.

Digitized When some type of data is converted into numbers. 
When you record audio on a computer, the audio is digi-
tized so that it can be stored in the computer’s memory, 
manipulated (edited), shown on screen etc.

DirectX System routines for Windows 95 and Windows NT, for 
playing back audio, video and other media components. 
Also see Multimedia Extensions.

Dist An abbreviation for Distortion.

Distortion When a sound sounds “dirty” it is distorted. This can ei-
ther be a deliberate effect (as when you add distortion to 
an electric guitar sound) or unintentional as when you 
record a signal on a tape recorder, with too high a level.

Dynamics The difference between weak and strong levels.

Envelope A device on a synthesizer used for controlling the 
“shape” of a sound. An envelope usually has parameters 
like Attack and Decay.
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Feedback When an output signal is routed back to the input, in var-
ious amounts. In this case, it is a setting in a Delay, that is 
used for creating repeating echoes.

Filter In this case a device used for introducing timbral changes 
to a sound.

Focus In this case, the section with “the focus” will be the target 
for some operation. For example, when you Paste, the 
Pasted material will appear in the section with the focus.

Focus bar A visual display in ReBirth RB-338 (an orange bar) that 
shows you which Section has the Focus (see above).

Instrument In this case, a drum sound or rhythm sound in ReBirth’s 
Rhythm Section.

Latency In this case, the inherent delay in the audio part of a com-
puter system. See page 155.

MIDI A system for transmitting musical performance data (not 
audio!) between musical instruments, computers and re-
lated devices. MIDI is an acronym for Musical Instrument 
Digital Interface.

MIDI Clock A part of MIDI used for synchronizing playback devices 
to each other so that they all play at the same tempo.

Mixer In this case, a device that is used formixing sounds to-
gether and to control basic aspects of sound such as vol-
ume, panning and timbre.

MME Abbreviation for Multimedia Extensions.

Multimedia Extensions A set of system routines introduced with Windows 3.x, 
used for standardizing audio and other media handling 
under Windows. Also See DirectX.

OMS Open Music System. A system for standardized handling 
of MIDI on Macintosh and PC computers. Developed by 
Steinberg Soft- & Hardware GmbH and Opcode Systems 
Inc. Only the Macintosh version of ReBirth RB-338 uses 
OMS.

Pattern In this context, a short snippet of music, a synth or rhythm 
phrase.

Pattern Selector Buttons for selecting Patterns.

Resonance In this case, a Filter control. Used for giving the sound a 
more prominent character and “hollow” quality.

Rhythm Instrument In this case, one of the sounds available in the Rhythm 
Section in ReBirth RB-338.

Rhythm Section The part of ReBirth that provides the rhythm and drum 
sounds.

Section ReBirth has six sections (machines, devices, parts): one 
Rhythm section, two Synth sections , one Delay section, 
one Distortion section and one Master section..

Section focus See Focus.
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Sequencer A device that records and plays back a musical perfor-
mance. 

Shared Instrument Some rhythm sounds in ReBirth RB-338 are mutually ex-
clusive, that is only one of them can play at a time. These 
are called shared instruments.

Sound selector A: The large knob in the ReBirth rhythm section used for 
selecting sounds. B: the sound legends on the rhythm sec-
tion front panel, also used for selecting sounds.

Step Patterns are divided into steps. Each step plays a rhythm/
synth sound. One step represents a sixteenth note.

Sync Abbreviation for Synchronization.

Synchronization In this context: when two or more devices are “locked to 
each other” in some way, so that they play together, for 
example at the same tempo.

Synth Section In ReBirth RB-338, the two synth sections provide all the 
synthesizer sounds.

Tuning Controlling the pitch of a sound. 

Underruns When data is output from a Buffer at a faster pace than it 
is coming in. As you understand this is an impossible sit-
uation that normally causes glitches of some kind.

Wave (.WAV) The standard audio file format on PC computers.

Waveform The “shape” of a sound. On many synthesizers you select 
various waveforms to get a basic character for your 
sound, before shaping it with Envelopes, Filters etc.
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The tables in this appendix show all the MIDI messages used in the Standard 
Mapping mode.

Mixers

This table shows you which MIDI Controller messages are used for the variou
controls in the Mixers

Controls in the Synths

This table shows you which MIDI Controller messages are used for the variou
controls in the two synth sections:

Control: Synth 1: Synth 2: Rhythm:

Level 11 14 17

Pan 12 15 18

Delay Amount 13 16 19

Control: Synth 1: Synth 2:

Waveform 20 27

Tune 21 28

Cutoff 22 29

Reso 23 30

Env Mod 24 31

Decay 25 32

Accent 26 33
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Controls in the Rhythm Section

This table shows you which MIDI Controller messages are used for the variou
controls in the rhythm section:

Control: MIDI Ctrl #: Comment:

AC Level 34

BD Level 35

BD Tone 36

BD Decay 37

SD Level 38

SD Tone 39

SD Snappy 40

LT Level 41

LT Tune 42

LT Switch 43  On/Off

MT Level 44

MT Tune 45

MT Switch 46  On/Off

HT Level 47

HT Tune 48

HT Switch 49  On/Off

RS Level 50

RS Switch 51  On/Off

CP Level 52

CP Switch 53  On/Off

CB Level 54

CY Level 55

CY Tone 56

CY Decay 57

OH Level 58

OH Decay 59

CH Level 60

Instrument Selection 61
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Master and Effects Sections

This table shows you which MIDI Controller messages are used for the variou
controls in the Master and effect sections:

Section: Control: MIDI Ctrl. #:

Master Level 7

PCF Pattern 62

Mode (LP/HP) 63

Freq 64

Q 65

Amount 66

Decay 67

Delay Steps (1-32) 68

Triplet mode 69

Pan 70

Feedback 71

Dist Amount 72
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Various Switches

This table shows which keys (MIDI Note messages) that can be used in all m
for various functions on the panel:

Keyboard MIDI Key Note Number Function
G#4 80 Rhythm – PCF On/Off
G4 79 Rhythm – Dist On/Off
F#4 78 Rhythm – Mix On/Off
F4 77 Synth 2 – PCF On/Off
E4 76 Synth 2 – Dist On/Off

D#4 75 Synth 2 – Mix On/Off
D4 74 Synth 1 – PCF On/Off
C#4 73 Synth 1 – Dist On/Off
C4 72 Synth 1 – Mix On/Off
B3 71 Dist – Enable

A#3 70 Delay – Enable
A3 69 PCF – Enable

G#3 68 Transport – Bar +
G3 67 Transport – Bar –
F#3 66 Transport – Record
F3 65 Transport – Stop
E3 64 Transport – Play

D#3 63 Focus to Rhythm
D3 62 Focus to Synth 2
C#3 61 Focus to Synth 1

C3 60 Select Pattern/
Program Synth
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Pattern Selection

When “Select Patterns from Keyboard” is activated on the Options menu, the
lowing keys (MIDI Note numbers) can be used for select Patterns.

Keyboard MIDI Key Note Number Function
G#2 56 Rhythm – Pattern 8
G2 55 Rhythm – Pattern 7
F#2 54 Rhythm – Pattern 6
F2 53 Rhythm – Pattern 5
E2 52 Rhythm – Pattern 4

D#2 51 Rhythm – Pattern 3
D2 50 Rhythm – Pattern 2
C#2 49 Rhythm – Pattern 1
C2 48 Rhythm – Bank D
B1 47 Rhythm – Bank C

A#1 46 Rhythm – Bank B
A1 45 Rhythm – Bank A

G#1 44 Rhythm – Pattern On/Off
G1 43
F#1 42
F1 41
E1 40 Synth 2 – Pattern 8

D#1 39 Synth 2 – Pattern 7
D1 38 Synth 2 – Pattern 6
C#1 37 Synth 2 – Pattern 5
C1 36 Synth 2 – Pattern 4
B0 35 Synth 2 – Pattern 3

A#0 34 Synth 2 – Pattern 2
A0 33 Synth 2 – Pattern 1

G#0 32 Synth 2 – Bank D
G0 31 Synth 2 – Bank C
F#0 30 Synth 2 – Bank B
F0 29 Synth 2 – Bank A
E0 28 Synth 2 - Pattern On/Off

D#0 27
D0 26
C#0 25
C0 24 Synth 1 – Pattern 8
B–1 23 Synth 1 – Pattern 7

A#–1 22 Synth 1 – Pattern 6
A–1 21 Synth 1 – Pattern 5

G#–1 20 Synth 1 – Pattern 4
G–1 19 Synth 1 – Pattern 3
F#–1 18 Synth 1 – Pattern 2
F–1 17 Synth 1 – Pattern 1
E–1 16 Synth 1 – Bank D

D#–1 15 Synth 1 – Bank C
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D–1 14 Synth 1 – Bank B
C#–1 13 Synth 1 – Bank A
C–1 12 Synth 1 – Pattern On/Off

Keyboard MIDI Key Note Number Function
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Synth Section Switches

When “Program Synth from Keyboard” is activated on the Options menu, and
focus (see the main ReBirth manual) is set to one of the synths, the following 
tions can be activated via MIDI note messages:

Keyboard MIDI Key Note Number Function
G#0 32 Pitch Mode On/Off
G0 31 Step
F#0 30 Back
F0 29 Note/Pause
E0 28 Slide

D#0 27 Accent
D0 26 Octave Up
C#0 25 Octave Down
C0 24 Pitch C
B–1 23 Pitch B

A#–1 22 Pitch A#
A–1 21 Pitch A

G#–1 20 Pitch G#
G–1 19 Pitch G
F#–1 18 Pitch F#
F–1 17 Pitch F
E–1 16 Pitch E

D#–1 15 Pitch D#
D–1 14 Pitch D
C#–1 13 Pitch C#
C–1 12 Pitch C
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Rhythm Section Switches

When “Program Synth from Keyboard” is activated on the Options menu, and
focus (see the main ReBirth manual) is set to the Rhythm section, the following 
functions can be activated via MIDI note messages:

Keyboard MIDI Key Note Number Function
D#1 39 Instrument – CH
D1 38 Instrument – OH
C#1 37 Instrument – CY
C1 36 Instrument – CB
B0 35 Instrument – CP

A#0 34 Instrument – RS
A0 33 Instrument – HT

G#0 32 Instrument – MT
G0 31 Instrument – LT
F#0 30 Instrument – SD
F0 29 Instrument – BD
E0 28 Instrument – AC

D#0 27 Step 16 - On/Off
D0 26 Step 15 - On/Off
C#0 25 Step 14 - On/Off
C0 24 Step 13 - On/Off
B–1 23 Step 12 - On/Off

A#–1 22 Step 11 - On/Off
A–1 21 Step 10 - On/Off

G#–1 20 Step 9 - On/Off
G–1 19 Step 8 - On/Off
F#–1 18 Step 7 - On/Off
F–1 17 Step 6 - On/Off
E–1 16 Step 5 - On/Off

D#–1 15 Step 4 - On/Off
D–1 14 Step 3 - On/Off
C#–1 13 Step 2 - On/Off
C–1 12 Step 1 - On/Off
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The pictures on the following pages show the 34 PCF patterns (see page 57).

The length of a Pattern is important since it determines the repetition. Let’s use
examples to illustrate this:

• Pattern 4 is a sixteenth note pattern that is 12 steps long. This means it re-
peats itself after 12 sixteenth notes (three quarters of a measure, in 4/4).

• Pattern 41 is a thirtysecond note pattern that is 28 steps long, which means 
it repeats itself after 14 sixteenth notes.

The height of the bars show the dynamics of the pattern, that is, the “velocity”
the triggering of each step.

16th Note Patterns

In the first 34 Patterns, each step represents a sixteenth note. The total length 
but the maximum length is 32 steps (two bars).

Pattern 0

Pattern 1

Pattern 2

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16
- 180 - 



Pattern 3

Pattern 4

Pattern 5

Pattern 6

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16
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Pattern 7

Pattern 8

Pattern 9

Pattern 10

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16
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Pattern 11

Pattern 12

Pattern 13

Pattern 14

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16
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Pattern 15

Pattern 16

Pattern 17

Pattern 18

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16
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Pattern 19

Pattern 20

Pattern 21

Pattern 22

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16
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Pattern 23

Pattern 24

Pattern 25

Pattern 26

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16
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Pattern 27

Pattern 28

Pattern 29

Pattern 30

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16
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Pattern 31

Pattern 32

Pattern 33

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16
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32nd Note Patterns

In Pattern 35 to 46, each step represents a thirtysecond note. Again, the leng
ies, but the maximum length is 32 steps (one bar).

Pattern 34

Pattern 35

Pattern 36

Pattern 37

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32
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Pattern 38

Pattern 39

Pattern 40

Pattern 41

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32
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Pattern 42

Pattern 43

Pattern 44

Pattern 45

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32
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Keyboard Shortcuts 21
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Menus

File menu

Edit menu

Command: Mac: PC:

New [Command]-[N] [Control]-[N]

Open [Command]-[O] [Control]-[O]

Close [Command]-[W] [Control]-[W]

Save [Command]-[S] [Control]-[S]

Song Information [Command]-[I] [Control]-[I]

Quit [Command]-[Q] [Control]-[Q]

Command: Mac: PC:

Cut [Command]-[X] [Control]-[X]

Copy [Command]-[C] [Control]-[C]

Paste [Command]-[V] [Control]-[V]

Random Accents etc. [Command]-[R] [Control]-[R]

Copy Touched Controls to Song [Command]-[T] [Control]-[T]
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Transport Controls
The following transport commands can be executed from the numeric key pad
the left on the computer keyboard:

Pattern Selection
To select Patterns from the computer keyboard, make sure “Select Patterns f
Keyboard” is selected on the Options menu. Use the typewriter part of the com
ter keyboard!

This assumes you are using an American keyboard. If not, check the illustratio
page 18 instead. The keys are on absolute positions on the keyboard, not on c
character positions.

Command: Mac: PC:

Stop [0] [0]

Play [Enter] [Enter]

Stop/Play [space bar] [space bar]

Record [*] [*]

Fast Forward [=] [Page Up]

Rewind [Num Lock] [Page Down]

Go to Loop Start [1] [1]

Go to Loop End [2] [2]

Next Bar [8] [8]

Previous Bar [7] [7]

Tempo Up [+] [+]

Tempo down [–] [–]

Pattern: 1 2 3 4 5 6 7 8

Synth 1: [1] [2] [3] [4] [5] [6] [7] [8]

Synth 2: [Q] [W] [E] [R] [T] [Y] [U] [I]

Rhythm: [A] [S] [D] [F] [G] [H] [J] [K]
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Synth Programming
To program the synth section from the computer keyboard, make sure “Progr
Synth from Keyboard” is selected on the Options menu.

This assumes you are using an American keyboard. If not, check the illustratio
page 37 instead. The keys are on absolute positions on the keyboard, not on c
character positions.

Command: Mac/PC:

Step [Return]

Back [Backspace]

C [C]

C# [F]

D [V]

D# [G]

E [B]

F [N]

F# [J]

G [M]

G# [K]

A [,] (comma)

A# [L]

B [.] (period)

C [/]

Note/Pause [–]

Accent [P]

Slide [[](left bracket)

Octave Down [;](semicolon)

Octave Up [‘] (apostrophe)

Tab “Tap” Rhythm

Shift Delete notes during playback
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Rhythm Tap Programming
As described on page 26, you can “tap” the rhythm on the keyboard.This assum
you are using an American keyboard (see page 26).

Command: Mac/PC:

– AC

A BD

S SD

D LT/LC

F MT/MC

G HT/HC

H RS/CL

J CP/MA

K CB

L CY

; OH

‘ CH

Shift Delete notes during playback
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A
About ReBirth RB-338 140, 152
AC 126
Accent

Rhythm 29, 126
Synth button 39, 129, 131
Synth knob 43

Adjust Sync 84, 94, 145
AIFF files 101, 119, 141
Alter 48, 143
AMD 159
Amount (Distortion) 54, 136
Amt 62, 135
Apple menu 140
Audio

Buffer 10, 12
Exporting 119
Playing in background 100
Setting up 8, 12
Sharing on Mac 101
Sharing under Windows 100

Audio card
General 154
Mac and Cubase 86
Macintosh 160
PC and Cubase 87
Selecting 9
Sharing audio 100, 101

Audio Card Driver 9, 145, 157
Audio Quality 154
Audio Sharing 86

B
Back 34, 129
Background playback 100
Bank selector 124
BD 126
BP 61, 135
Buffer size 10, 12

C
CB 126
CH 126
CL 126
Clear Pattern 142
Clearing

General 46
Synth 40, 128

Close 140
Computer 17
Computer keyboard 17, 192
Contact Steinberg 152
- 19
Controllers
For controlling ReBirth 103
Specifying 108
Standard implementation 170

Copy
in Song 75
Pattern 45

Copy Loop 149
Copy Pattern 142
Copy Touched Controls 69, 72, 150
CP 126
Crackle safe 12
Cubase 78
Customizing Songs 113
Cut

Loop 75, 149
Pattern 45, 142

Cutoff 42, 130
CY 126
Cyrix 159

D
Dec 62, 135
Decay

Rhythm 31, 126
Synth 43, 130

Delay
Amount 132
Feedback 137
Introduction to 55
Meter 137
On/off 137
Pan 138
Reference 137
Steps (Length) 137

DirectX 9, 156
Distortion

Amount 136
Introduction to 53
On/Off 136
Reference 136
Switch 133

Down 129

E
Effects

Delay 55
Distortion 53
Introduction to 50
PCF 57

Env. Mod. 43
Export Loop as AIFF/Wave 101, 119, 141
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F
F.Back 56, 137
Fast Forward button 123
Feedback 56, 137
Focus Bar 19, 46
Freq 61, 135

G
Get Free Songs 152
Get Tech Support 152

H
HC 126
Help 152
Hi-hat (open vs. closed) 29
HT 126
Hubi’s Loopback Device 82, 93

I
Initialize Loop from Pattern Mode 73, 149
Initialize Song from Pattern mode 66, 150
Intel 159

K
Keyboard

Rhythm Programming From 26
Selecting Patterns From 18
Shortcuts 192
Synth Programming From 37

L
Latency 155
LB1 93
LC 126
Learn 108, 148
Level

Introduction to 21
Master 51
Mixer 51
Rhythm 31

Live Sync 97
Loop

On/Off 123
Playback 65
Recording 74
Start and Length 123

LP 61, 135
LT 126
- 19
M
MA 126
Master

Level 20, 51, 139
Meter 139

Master Section 139
MC 126
Meter

Delay 137
Distortion section 136
Master 139
Mixer 132

MIDI
Indicator 97, 122
Input 145
LED 97, 108, 122
Remote Control 103
Standard Mapping Table 170

MIDI Channel 104, 145
MIDI Clock 89, 97
MIDI Clock Sync 90
MIDI Clock Sync Enable 145
MIDI Control ID 148
MIDI Indication 108
MIDI Input 90, 105, 145
MIDI Port 91
Mixers 20, 132
Mixing

Introduction to 50
Levels 51
Master Level 51
Muting 52
Pan 52

MME 156
Mode 61, 135
MT 126
MultiMedia Extensions 156
Multitasking friendly 12
Muting 52

N
New 113, 140
Note/Pause button 129

O
Octave 39
OH 126
OMS 79, 91
Open 140
Opening Songs 115
Order ReBirth 152
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P
Page Setup 141
Pan

Delay 56, 138
Mixer 52, 132

Paste
Pattern 45, 142
Song 75

Paste at Song Position 149
Paste Replace at Song Position 75, 149
Pattern

Length 30, 40
Moving between Songs 116
PCF 134
Rhythm programming 22
Selecting 18
Synth programming 32
Tapping 26, 38

Pattern Editing
Alter 48
Copy 45
Cut 45
Paste 45
Random 47
Shift 47
Transpose 48

Pattern mode 15, 64
Pattern selector 124
Patterns and knob settings for new Songs 146
PCF

About 57
Amt 62, 135
BP/LP 61
Dec 62, 135
freq 61, 135
Mode 61, 135
Pattern 61, 134
Pattern diagrams 179
Q 62, 135
Routing 60
Switch 133

Pitch buttons 128
Pitch Mode 36, 128
Pitches

from Keyboard 37
Setting in existing Pattern 36
Specifying 35

Play Ahead 145
Play button 122
Playback Performance slider 145
Preferences 144
Program Synth from Keyboard 151, 195
- 20
Q
Q 62, 135
Quick Mapping 107, 108
Quick Setup 147
Quit 141

R
Random 47, 143
ReBirth knob 148
Received MIDI Control ID to Learn 108, 148
Recent Documents 141
Record button 123
Remote MIDI

Quick Mapping 107, 108
Standard Mapping 107, 170

Remote MIDI Control 103, 145
Repeating measures 76
Reso 130
Resonance 42, 130
Rewind button 123
Rhythm Patterns

Accents 29
Adding notes 25
Clearing 30
Lengths 30
Programming 22
Removing notes 25
Tap recording 26

Rhythm sounds
Parameters 31
Reference 126
Selecting 24
Shared sounds 28

RS 126

S
Save 140
Save As 140
Saving Songs 114
SD 126
Select Patterns from Keyboard 151, 194
Shared sounds 126
Shift 47, 143
Slide 39, 129
Snappy 31, 127
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Song
Customizing 113
End 68
Introduction to 64
Moving Pattern between 116
New 113
Opening 115
Playing 65
Punching In and Out 70
Recording Control changes 71
Recording Pattern changes 67
Saving 114

Song Editing
Copy 75
Cut 75
Paste 75
Paste Replace 75
Remove 75
Repeating 76

Song Mode 15, 64, 121
Song Position Pointers 95, 97
Sound Manager 12, 160
Sound Selector 24, 125
Standard Mapping 107
Standard MIDI Mapping Table 170
Startup Song 113
Stay on Top 116, 151
Step

Button 34, 129
Display 124, 129
Rhythm 25

Steps (Delay setting) 56, 137
Stop button 122
Straight notes/Triplets 56, 137
Sync Delay 84, 94
Sync Indicator 98, 122
Sync to MIDI Clock 90, 151
Synchronization

Considerations 84
Cubase 79
Delay 94
Introduction to 89
Live Sync 97
Song Position Pointers 95, 97
Sync Indicator 98
Tempo changes 96
Tempo Display 95
To external device 90
To other program 91
- 20
Synth Patterns
Accent button 39
Clearing 40
Length 40
Notes or pauses for start 34
Octave 39
Pitch Mode 36
Programming 32
Programming from keyboard 37
Slide 39

Synth settings
Accent 43
Cutoff 42
Decay 43
Env. Mod. 43
Resonance 42
Tune 42
Waveform 42

System 8 13

T
Tap recording

Rhythm 26
Synth 38

Tempo 122
Tempo changes 96
Tempo display 95
Tone 31, 126
Transport Panel 121
Transpose 48, 143
Tune

Rhythm 31, 127
Synth 42, 130

U
Underruns 145
Up 129
Use Current Song 113

V
Values, setting 16
Volume

Master 139
Mixers 51, 132
Rhythm 31

W
Wave files 101, 119, 141
Waveform selector 42, 130
Windows menu 115, 151
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